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Domain name resolution can be checked by typing nslookup domain_name in DOS Command prompt
Application & Database Configuration
Where the trust has separate Application and Database servers both will need to resolve when logged on via VPN
This can be done via the hosts file if necessary.

Single server Configuration
The server name will need to resolve when logged on via VPN
This can be done via the hosts file if necessary
[bookmark: _Toc35504150]Firewall Ports
Application & Database configuration

Their remote workstation IP address will need to access 

Application Server 
	Port
	Use

	80
	If using http and for viewing cannulation form

	443
	If using https

	22
	If using the application server for storing documents, scanned images and dictations



Database Server
	Port
	Use

	1949
	Postgres port



Trust ftp/sftp server
If the trust use their own server to store dictations, documents and scanned images
	Port
	Use

	21
	If using an ftp server

	22
	If using an sftp server



[bookmark: _Toc35504151]CRIS Installation

See document RIS_PD951_HSS_CRIS_Launcher_Client_Installation


	
Once installed it is advisable to increase the time in the XR setting GENERAL.Inactivityshutdown to prevent CRIS shutting down completely as a lot of data is downloaded on initial start up. The setting GENERALInactivityLogout should be kept the same or decreased. This will protect the data within CRIS but prevent the user having to wait for a full download.

[bookmark: _Toc35504152]Voice Recognition

To install VR please read the attached Guide
[bookmark: _Toc35504153]Dragon 11

See document CRIS_CRIB_VR_275_Voice_Recognition_11
[bookmark: _Toc35504154]
[bookmark: _Toc35504155]Dragon 12
[bookmark: _Toc35504156]
See document CRIS_CRIB_VR_276_Voice_Recognition_12

[bookmark: _Toc35504157]Dragon 13

See document CRIS_CRIB_VR_276_Voice_Recognition_13


For those users that will be using CRIS from home and reporting with Dragon voice recognition, Wellbeing recommend they create a local dragon profile with the same name as the current roaming profile being used for each user. (commands and custom words can be imported)

The dragon profile will be local only to that computer, Wellbeing recommend setting up dragon this way to reduce the overhead that will come with managing a network profile. Less configuration is required and no network share is required either which can reduce the possibility of users requiring support, especially if working out of hours.

The document below advises how to export their words and phrases from their network profile and import them into the local profile.




We would also recommend exporting your words and commands to a memory stick regularly  so that you can reimport in case of hard disk issues.

1© Wellbeing Software 2018. Copyright details to be placed here. All Rights Reserved.
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These materials are or comprise restricted and proprietary confidential information of Healthcare Software 


Solutions.  Disclosure to or use by the recipient shall not convey any intellectual property rights in these materials. 


The right to use these materials by the recipient is subject to restrictions and limitations contained in the Provision 


of Integrated Care Record System and Associated Services Agreement and related agreements. 


 


Confidentiality 
All information in this document is provided in confidence for the sole purpose of adjudication of the document 


and shall not be used for any other purpose and shall not be published or disclosed wholly or in part to any other 


party without HSS prior permission in writing and shall be held in safe custody. These obligations shall not apply to 


information which is published or becomes known legitimately from some source other than HSS. Many of the 


product, service and company names referred to in this document are trademarks or registered trademarks. They 
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1. Introduction 


Purpose 
 


This document is aimed at sites that are in the process of implementing, or have already implemented the CRIS 


Radiology Information System with integrated Dragon Medical Version 11 Voice Recognition (VR) software.  


It aims to introduce the main features of the Dragon Medical 11 software and to deploy this functionality to improve 


efficiency and enhance reporting workflows in a modern RIS / PACS environment. 


   
These areas are: 


 


 Sections relevant to IT Personnel / PACS Engineers 


 Overview of CRIS / Dragon Integration 


 Dragon Medical 11 System Requirements 


 Important Considerations 


 Related User Documentation 


 Installation and Setup 


 Dragon Setup & Configuration 


 Roaming Profiles 


 Creating a Dragon User for Set-up 


 Creating Roaming Dragon Users 


 Activating CRIS and Dragon Integration 


 Creating User Specific Text Commands 


 Best Practice, Correction and Troubleshooting 


 General Housekeeping 


 Frequently Asked Questions 


 


To get the most out of the integration between CRIS and Dragon, it is essential that the configuration of Dragon 


should be undertaken as described within this document. 
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Audience 
 
This document is aimed at HSS CRIS customers who have Dragon Naturally Speaking 11 Medical.  


 


It is designed to be used by RIS/PACS Administrators and/or IT support personnel. This document is also available 


for reference by PACS Workstation Engineers. 


 


The installation process will typically require administration level rights, and it may be necessary to contact your 


PACS provider to install the Dragon Software on PACS workstations if you do not have workstation administrator 


rights. 


 


Sections relevant to IT Personnel / PACS Workstation Engineers 
 


Any IT Personnel or PACS Workstation Engineers who have been tasked to install the CRIS client and Dragon 


Software should refer to the following sections. This information should also be reviewed by RIS / PACS Managers 


tasked to support the Dragon product in the department. 


 


DESCRIPTION PAGE 


DRAGON 11 SYSTEM REQUIREMENTS 6 


INSTALLATION AND SETUP 10 


INITIAL SET-UP AND INSTALLATION (APPLYING DEFAULT SETTINGS TO ALL USERS) 10 


MODIFYING EXISTING INSTALLATIONS (APPLYING DEFAULT SETTINGS TO ALL USERS) 13 


DRAGON SETUP & CONFIGURATION 16 


ROAMING PROFILES 19 


CONFIGURING ROAMING PROFILES IN DRAGON NATURALLYSPEAKING 20 


CREATING A DRAGON USER FOR SET-UP 23 


ACTIVATING CRIS AND DRAGON INTEGRATION 29 


ACTIVATING XR SETTINGS 29 


LINKING CRIS AND DRAGON PROFILES 31 


ESSENTIAL HOUSEKEEPING – SETTING UP AND SCHEDULING THE ACCOUSTIC OPTIMISER 46 


 


2. Overview of CRIS and Dragon Integration 


Dragon Naturally Speaking 11 Medical provides a powerful voice recognition system which has been fully integrated 


to the HSS CRIS system in order to facilitate the rapid transcription of clinical reports.  


 


Dragon Naturally Speaking 11 Medical software incorporates a comprehensive vocabulary of medical words and 


phrases including a Radiology dictionary that enabling Dragon to recognise complex medical terms, and also 


develop and learn in context to the individual user’s vocabulary, and voice profile. 


 


Dragon improves by recording data and storing all spoken words and phrases in context to the user, and by 


optimizing the data regularly when used in conjunction with the essential Dragon utility the ‘Acoustic and Language 


Model Optimiser’ which should be run weekly for the best result in terms of recognition and maximum productivity. 







 
   
 
 


© Healthcare Software Solutions 2015   All Rights Reserved Commercial In Confidence 
Effective Date – ESM 05/11/2015   
HSS Doc ref:  CRIS_CRIB_VR_275_Voice_Recognition_11_V5.0.docx Page 7 of 56 


 


 


 


Dragon 11 System requirements 
 


Minimum System Requirements: 


 CPU: 1 GHz Intel Pentium or equivalent AMD processor, or 1.66 GHz Intel Atom processor. (SSE2 instruction set 


required.) 


 Processor Cache: 512 KB 


 Memory (RAM): 1 GB for Windows XP and Windows Vista, 2GB for Windows 7 and Windows Server 2003/2008. 


 Free hard disk space: 2.5 GB (2.8 GB for localized non-English versions) 


 Windows 7 (32-bit and 64-bit) 


 Windows Vista SP1 and SP2 (32-bit and 64-bit) 


 Windows XP SP2 and SP3 (32-bit only) 


 DVD-ROM drive (required for installation) 


 Sound card capable of supporting 22 kHz 16-bit recording. 


 


Recommended Specifications: 


 CPU: 2.4 GHz Intel Dual Core or equivalent AMD processor. (IMPORTANT: SSE2 instruction set required) 


 Processor Cache: 2 MB 


 Free hard disk space: 5 GB 


 RAM: 2 GB RAM for XP and Vista, and 4 GB for Windows 7, 8 and 2008 64-bit/2012 


 Microsoft Internet Explorer 8, 9, 10 (free download at www.microsoft.com) Creative® Labs Sound Blaster® 16 


or equivalent sound card supporting 16-bit recording 


 USB or DVD-ROM drive required for installation Supported Operating Systems:  


 Microsoft Windows 8, 32-bit and 64-bit 


 Microsoft Windows 7, 32-bit and 64-bit 


 Microsoft Windows Vista SP2, 32-bit and 64-bit 


 Microsoft Windows XP SP3, 32-bit only 


 Windows Server 2008, SP1, SP2, and R2, 32-bit and 64-bit (Windows 2008 R2 64 bit SP2 ONLY) 


 


Important Considerations 
 


CRIS > DRAGON INTEGRATION 


 
It is very important that you DO NOT open Dragon Naturally Speaking independently on a workstation when CRIS 


is running with VR integration turned on. You must ensure CRIS is NOT running before you start Dragon Naturally 


Speaking to perform any administrative tasks on profiles/users. 


 


Within normal day to day use CRIS will be used to start and close the Dragon NaturallySpeaking software. Dragon 


should not be opened separately when CRIS is running.  


 


You should be aware that this does mean the Dragon Bar will not, and should not be displayed. However all required 


Dragon Tools are still accessible by right-clicking the Dragon Bar Icon in the Windows System Tray.  
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Failure to allow the CRIS System to launch Dragon will result in a reduction in the quality of integration, or in some 


cases disable the features altogether. This is due to the fact that Dragon will attempt to work independently, in 


effect ignoring commands sent by CRIS and leading to inconsistent results when reporting. 


 


CORRECTLY CONFIGURING DRAGON ROAMING 


 
The most common cause of incidents reported to the HSS helpdesk relate to incorrect set-up / configuration of 


Dragon roaming profiles. This is typically due to the following issues: 


 


 When setting up the roaming profiles via Dragon Administrative Settings. The network path where the roaming 


user profiles are stored must be either a persistent mapped drive or a full network UNC ‘Universal Naming 


Convention' path to where the user Dragon roaming profiles are to be stored (i.e. 


\\servername\Dragonprofiles). 


 An IP address in the roaming network path in the Dragon Administrative Settings is not supported by Dragon. 


Only a mapped drive or full UNC path can be used. 


 When creating the folder for both the network location and the local directory for cache folder in the 


administration settings, it's recommended to use a short name with no spaces. For example 


\\username\vrprofiles and not \\servername\ Dragon users profiles folder. 


 Dragon does not backup roaming profiles. The roaming profiles will need to be stored on a share that is backed 


up regularly.  


 Dragon must be installed using a windows account with Administrator rights not the actual Local Administrator 


account which should be disabled. 


 The roaming profiles must not be created using an Administrator account. They need to be created with the 


same user rights as the users who will use the profile and they must have the correct modify NTFS permissions 


to the profile folder. The administrator must not be the owner of the folder. 


 For sizing HSS would recommend 2GB per user, although the typically profile size is 500MB – 1GB. 


 


Full details regarding setting up and configuring Dragon Roaming correctly is contained in the ‘Roaming Profiles’. 


Section of this document. 
 
 
 
 
 
 
 







 
   
 
 


© Healthcare Software Solutions 2015   All Rights Reserved Commercial In Confidence 
Effective Date – ESM 05/11/2015   
HSS Doc ref:  CRIS_CRIB_VR_275_Voice_Recognition_11_V5.0.docx Page 9 of 56 


 


 


 


SETTING UP / SCHEDULING THE DRAGON ACOUSTIC LANGUAGE & MODEL OPTIMISER 
 


As you make and train corrections, train new words, use commands, and perform additional training, Dragon stores 


the acoustic and language data in an archive and uses it to enhance recognition accuracy and ‘learn’ any changes 


you have made.  
 


HSS strongly recommend that the ‘Acoustic and Language Model Optimiser’ is scheduled to run weekly in order to 


ensure that users always have access to the most up-to-date and streamlined profiles. Failure to run the ‘Acoustic 


and Language Model Optimiser’ will result in a degeneration of recognition, and the appearance that Dragon is not 


learning in spite of any training undertaken by the user. 
 


HSS also suggest that the ‘Acoustic and Language Model Optimiser’ is run from server where the profiles are stored 


as this is the most time efficient in terms as it negates network speed issues, any loss of access to profiles and 


should also be subject to the standard system backup.  
 


Consequently, it is essential that the ‘Acoustic and Language Model Optimiser’ is set-up and scheduled to run as 


soon as CRIS > Dragon Voice Recognition is in use in order to ensure that successful running of the modules 


throughout the life of the system.  


 


Full details regarding setting up and configuring the ‘Acoustic and Language Model Optimiser’ is contained in the 


‘Essential Housekeeping’ section of this document. 


 


IGNORING / UNINSTALLING PHILIPS SPEECHMIKE DEVICE CONTROL SOFTWARE 
 
If the Trust have opted to purchase or use existing Philips SpeechMike’s as an alternative to the recommended VR 


Headset you should ensure that you DO NOT install Philips SpeechMike Device Control Software. HSS have 


identified that CRIS > Dragon VR will not function as expected if Philips SpeechMike Device Control Software are 


installed.  


 


This is particularly in relation to the behavior of the record button. You SHOULD NOT install any software supplied 


via media with the Philips SpeechMike. The device should only be installed using USB plug and play when in use 


with the CRIS > Dragon integration. 


 


Alternatively, if you (or IT) have already installed the Philips SpeechMike Device Control Software, you should 


uninstall this completely, otherwise HSS cannot guarantee the correct operation of the Philips SpeechMike when 


used in conjunction with the CRIS > Dragon integration. 


 


CRIS > DRAGON DOCUMENTATION 
 


The following additional CRIS > Dragon documentation is designed to be used in conjunction with this document: 
 


CRIS_CRIB_VR_292_Dragon_11_Using_Voice_Recognition.doc - Overview of using CRIS with the integrated 


Dragon Voice Recognition and in-built CRIS commands aimed primarily at End Users. 
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DRAGON DOCUMENTATION 
 


HSS would also recommend that customers make use of the official Dragon documentation and knowledge bases 


as this is an invaluable source of information for IT and Dragon Users alike. 
 


Dragon Medical IT Administrators Guide 
 


Accessed via Start Menu > Dragon Medical Tools > Dragon Medical IT Administrators Guide this section of the 


system provides technical details regarding Dragon Set-up and Configuration.  


 
 


 


 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


Dragon Naturally Speaking Help 
 


Searchable Basic Help on all aspects of using Dragon Naturally Speaking – accessed by right-clicking the Dragon Bar 


Icon in the Windows System Tray: 
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Please note: You should be advised that the Dragon Bar is not for use in conjunction with CRIS integration. 


 


On-line Support and Knowledge Base  
 


The ‘Nuance’ on-line Support and Knowledge base also provides a comprehensive, interactive source of information 


regarding usage, configuration, and troubleshooting in addition to known issues and future resolutions. 


 


This can be accessed via http://nuance.custhelp.com/app/utils/login_form/redirect/account%252Foverview 


where it will be necessary to create an account using your product serial number. 


 


3. Initial Set-up and Installation (Applying Default settings to ALL 


Users) 


 


Dragon software can be configured per Individual Profile using the ‘Typical’ Installation. However HSS strongly 


recommend that the ‘Custom’ Installation is used as standard since this allows the Trust to configure default 


required settings for ALL Users ensuring Dragon is correctly configured and does not need to be configured per 


user. 


 


Please note: If Dragon has already been installed at an earlier date, it is also possible to modify the installation of Dragon to set the default 
settings for ALL users retrospectively. Please proceed to the ‘Modifying Existing Installations’ section of this document for full details. 


 


 Insert the DVD for Dragon NaturallySpeaking, the following dialogue box will appear:  


 



http://nuance.custhelp.com/app/utils/login_form/redirect/account%252Foverview
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 Click [Next] to continue to the next step. If the installation does not start automatically, use ‘Windows Explorer’ 


to find and double-click setup.exe on the DVD. 


 Select ‘Custom’ from the ‘Setup Type’ menu and click [Next]: 


 


  


 


 Nothing needs to be changed on the screen below. Click [Next]: 
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 Ensure that you have ticked ‘Modify the application’s settings for all users’ and ‘modify the administrative 


settings’ via the Custom Set-up menu before clicking [Next]: 


 


 


 Click on the [Install] button to complete the installation.  


 


Once the installation is completed the Options configuration menu will appear to enable you to set default options 


for ALL Users.  


 


Proceed to ‘DRAGON SET-UP & CONFIGURATION’ for details of applying all recommended settings for Dragon 


within the CRIS Application. 
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Having undertaken all recommended configuration via the Options menu this will be followed by the Administrative 


Settings which enables you to configure Roaming Profile Set-up for ALL USERS. It is therefore important to ensure 


that the shared volume where the voice profiles are to be stored is correct. 


 


Proceed to ‘CONFIGURING ROAMING PROFILES IN DRAGON NATURALLY SPEAKING’ for full details. 
 


Modifying Existing Installations (Applying Default settings to  ALL Users) 
 


 It is also possible to modify the default settings for ALL USERS even in the event that the Dragon Software has 


already been installed on a terminal / workstation.  


 HSS strongly recommend that this is undertaken on all terminals running Dragon in order to ensure that ALL 


USERS have the correct configuration to ensure optimum usage and dictionary adaptation in conjunction with 


the CRIS system. 


 Insert the Dragon Naturally Speaking Installation DVD and use ‘Windows Explorer’ to find and double-click 


setup.exe on the DVD. 


 The following dialogue box will appear. Click [Next] to continue: 


 


 


 


 


 


 


 


 


 


 


 


 


 Select Modify from the following program maintenance menu and click [Next]: 
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 Nothing needs to be changed on the screen below. Click [Next]: 


 
 
 
 


 


 


 


 


 


 


 


 


 


 


 


 Ensure that you have ticked ‘Modify the application’s settings for all users’ and ‘Modify the administrative 


settings’ via the Custom Set-up menu before clicking [Next]: 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 An additional configuration menu will briefly appear followed immediately by the Options configuration menu 


to enable you to set default options for ALL Users.  


 


Proceed to ‘DRAGON SET-UP & CONFIGURATION’ for details of applying all recommended settings for Dragon 


within the CRIS Application. 
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Having undertaken all recommended configuration via the Options menu this will be followed by the Administrative 


Settings which enables you to configure Roaming Profile Set-up for ALL USERS. It is therefore important to ensure 


that the shared volume where the voice profiles are to be stored is correct  


 


Proceed to ‘CONFIGURING ROAMING PROFILES IN DRAGON NATURALLY SPEAKING’ for full details. 


 


Dragon Setup & Configuration 
 


This section describes the ‘Options’ menu changes required for using Dragon with CRIS.  The ‘Options’ menu will 


be displayed automatically when undertaking a Custom installation, or Modifying an Existing installation, or can 


be accessed via an Existing User by right-clicking on the Microphone icon located on the task bar and selecting 


‘Tools’ then ‘Options’ via the ‘Dragon Menu’. 


 


ESSENTIAL DRAGON CONFIGURATION SETTINGS 
 


The following screen-shots show the required Dragon Options Menu Configuration which must be applied correctly 


in order to ensure correct CRIS > Dragon Integration. Only Tabs / Screens which require modification are shown. 


Dragon MUST BE installed / configured using a Custom installation to ensure you can ‘Modify the Applications 


Setting for All Users’ (See Section Initial Set-up / Installation, or Modifying an Existing Installation). HSS 


recommend you confirm that the set-up is correct before proceeding to using Dragon VR or any workstation. 
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CORRECTION MENU 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


COMMANDS MENU 
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VIEW MENU 


 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


MISCELLANOUS MENU 


 


 


 


 


 


 


 


 


 


 


 


 


  


 


 


 


 


Please note: The ‘Speed vs Accuracy’ setting is greyed out as this setting is for individual profiles and not for all users. 
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DATA MENU 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


Please note: The option to ‘Store corrections in archive’ will determine whether or not a list of the user’s corrections will be stored for later 
use by the Acoustic and Language Model Optimizer (Having this turned OFF does not stop Dragon doing its normal adaptation and correction 
for the user). Click the [Archive Size] button to check the archive size is set to the standard default of 180 minutes of stored corrections. 


 


If this option is not selected before you run the ‘Acoustic and Language Model Optimiser’, you may see a message 


that there is not enough data for the ‘Acoustic and Language Model Optimiser’ to process. This option should be 


enabled whenever Dragon NaturallySpeaking is used for an extended period of time.  


 


4. Roaming Profiles 
 


How Roaming Profiles work 
 
The Roaming User feature in Dragon NaturallySpeaking lets you dictate at different locations connected to your 


network, without having to create and train individual user files at each location. Dragon roaming is essential if the 


Radiologists use more than one terminal to allow users to access their personal files/dictionary at any workstation. 


 


The ‘ROAMING DIRECTORY’ is just a standard windows folder which HSS would recommend is named ‘Dragon 11’ 


on a local shared network location anywhere the Trust IT chooses to set it up. HSS strongly recommend that this 


location is covered by the standard backup processes undertaken on a routine basis at Trust. For sizing HSS would 


recommend 2GB per user, although the typically profile size is 500MB – 1GB. 


 



mk:@MSITStore:C:/PROGRA~1/Nuance/NATURA~1/help/enx/power/dragon_enx.chm::/dictate/about_acoustic_optimizer.htm
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Roaming Profiles are handled using either a networked UNC 'Universal Naming Convention' path or a shared 


network drive which all users can access. If using a mapped drive this drive needs to be mapped as a persistent 


connection to each end user machine.  All users have their profile data saved centrally in this 'mapped' network 


drive so you will need to know the drive letter associated with this drive and any passwords needed to access it in 


order to configure this feature. 


 


ESSENTIAL CONFIGURATION - DRAGON ROAMING PROFILES 
 


The following guidelines should be followed when creating and configuring Dragon roaming profiles as failure to do 


will cause issues when the Dragon application, and is by far the most common cause of VR issues reported via the 


HSS Helpdesk. 


 


 When setting up the roaming profiles via Dragon Administrative Settings. The network path where the roaming 
user profiles are stored must be either a persistent mapped drive or a full network UNC ‘Universal Naming 
Convention’ path to where the user Dragon roaming profiles are to be stored (i.e. 
\\servername\Dragonprofiles). 


 An IP address in the roaming network path in the Dragon Administrative Settings is not supported by Dragon. 
Only a mapped drive or full UNC path can be used. 


 When creating the folder for both the network location and the local directory for cache folder in the 
administration settings, it's recommended to use a short name with no spaces. For example 
\\username\vrprofiles and not \\servername\ Dragon users profiles folder. 


 Dragon does not backup roaming profiles. The roaming profiles will need to be stored on a share that is backed 
up regularly.  


 Dragon must be installed using a windows account with Administrator rights not the actual Local Administrator 
account which should be disabled. 


 The roaming profiles MUST NOT be created using an Administrator account. They need to be created with the 
same user rights as the users who will use the profile and they must have the correct modify NTFS permissions 
to the profile folder. The administrator must not be the owner of the folder. 


 For sizing HSS would recommend 2GB per user, although the typically profile size is 500MB – 1GB. 
 


CONFIGURING ROAMING PROFILES IN DRAGON NATURALLYSPEAKING 
 


The ‘Administrative Settings’ window will be displayed automatically when undertaking a Custom Installation, 


Modifying an Existing Installation, or can be subsequently accessed by right-clicking the Microphone icon located 


on the task bar and choosing the ‘Tools’ menu followed by the ‘Administrative Settings’ option via the Dragon 


Menu Bar. 


 


Please note: You must close any active users in order to access this panel. You can close Users from the right-click Dragon Menu > Profile > 
Close User Profile 
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Please note: The above administrative settings must be set correctly on each terminal for .DRA (Acoustic Dragon files) to be created for each 
session. These DRA files are needed by the ‘Acoustic and Language Model Optimiser’. The ‘Acoustic and Language Model Optimiser’ must be 
installed and configured as per the Essential Housekeeping Instructions to ensure that Dragon continues to work as effectively an accurately 
as possible. 


 


Within the 'Administrative Settings' panel there are two main settings on the Roaming tab: 


 


 Network directory  


 Local directory  


 


NETWORK DIRECTORY 
 


This is the location(s) of the master roaming user files. You should add either a full UNC ‘Universal Naming 


Convention' path or a mapped drive followed by the directory in which you would like the profiles to go.  


(W:\Dragon11 is an example - If you do not have a directory created on your shared drive you will need to make 


one and ensure that it has ‘modify’ permissions for all the required users). 


 


LOCAL DIRECTORY 


 
This is the location where the roaming local profile will be created for each user while they are working which will 


synchronise to the roaming master profile on the server. The master profile on the server is always the most up to 


date version, so a user can logon to any Dragon workstation and their changes will always be the most current data. 
 


This includes the following files: 
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 .DRA files (Dragon Acoustic data) - Dragon is an audio application and it creates many large audio files called 


.DRA files. These can become very large in size as Dragon records every word the user says for learning and 


accuracy and stores it in these .DRA files. 


 MyCommands.dat file - All Dragon commands including custom commands. 


 Any changes to the local profile including - Phrases, Training, Mic Configuration etc.  
 


This is typically saved via C:\users\username\appdata\roaming\nuance\naturallyspeaking11. 
 


New IMPORTANT CONFIGURATION REQUIREMENTS – AMENDING LOCAL CACHE DIRECTORY 
 


HSS recommend that you amend the default local directory for ease of administration and troubleshooting. You  


should therefore create a ‘Dragonprofiles’ directory via the C:\cris3 folder as this ensures that the user has the 


correct NTFS permissions to write to this folder as this is where all changes to roaming profiles will be stored before 


being transmitted to the roaming profile directory. 


 


 


 


Please note: This is only applicable for new installations. Existing Dragon installations should not be modified, but it will be necessary to 
ensure that the current local directory folder has the correct modify NTFS permissions to the profile folder. It is also essential that all 
workstations have the same configuration (i.e. same folder on all workstations), otherwise the roaming profiles will not function correctly 
and you will encounter issues with saving and updating user profiles. 


 


MISCELLANEOUS TAB 
 


The ‘Miscellaneous’ tab is where you will find settings for the Backup Location of User Files and will need to be 


amended as per the following screenshot: 
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BACKUP LOCATION FOR USER FILES 


 
Dragon does not automatically backup any profiles when using roaming profiles. The backup settings are designed 


to specify where manual back-ups should be saved if invoked by the user themselves. You can choose to modify 


the default location but this will continue to be a manual task. HSS therefore strongly recommend that you ensure 


the Main Roaming Directory containing the master roaming profiles is covered by the standard backup processes 


undertaken on a routine basis at Trust. 


 


SCHEDULED TASKS TAB 


 
The ‘Scheduled Tasks’ tab is where you should ensure that the ‘Enable Scheduled Accuracy Tuning’ and ‘Let the 


User choose when to run the Accuracy Training and Data Collection’ should be disabled in favour of a centralised 


‘Acoustic and Language Model Optimiser’ which is scheduled to run weekly to maximise VR accuracy and 


productivity.  


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


Please refer to the ‘Essential Housekeeping Section’ of this guide for more information on the Acoustic Optimiser. 
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Creating a Dragon User for Set-up 
 


When installing Dragon for the first time it will be necessary to create a local ‘Set-up User’ to test that the options 


and roaming profiles are correctly configured ahead of adding subsequent users. 


 


You should therefore install the Dragon software as directed in this document and create a local ‘Set-up User’ as 


directed below ensuring that you click ‘Skip initial training of this user’. 


  


It is possible to dictate using a Headset (supplied with Dragon License) or a Philips Speech Mike (not supplied with 


Dragon License). The screens below will show how to setup a user. 


 


You will be asked to enter a range of information including a name for the profile, profile location (this will default 


if roaming is enabled), age, vocabulary (Radiology), accent and audio source. It will then give you chance to review 


your choices. (Shown below) 


  


 


Please note: If you are using a Philips Speech Mike you should ensure ‘Dictation Source = USB Microphone’. 
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Please note: If the microphone is held too closely to the user’s mouth the voice sample may not be recognised (the bar on the right-hand 
side of the screen will not move when then text is being read) which may adversely affect the recording volume for voice recognition. When 
completing the volume check you should ensure the volume bar is active and is therefore recognising the voice sample. 


  


Adjust Microphone – Volume Check 
 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


Adjust Microphone – Quality Check 
 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


Please note:  If the Quality Check fails you should check all connections of dictation kit, that no sound settings are on mute and if there is 
anything that can be done to minimise background noise – i.e. closing the office door. The volume and quality check will also need to be 
completed at least once at each workstation the user will use to report. This can be done at any time by right clicking on the bottom right 
Dragon icon then audio and check microphone. 


 







 
   
 
 


© Healthcare Software Solutions 2015   All Rights Reserved Commercial In Confidence 
Effective Date – ESM 05/11/2015   
HSS Doc ref:  CRIS_CRIB_VR_275_Voice_Recognition_11_V5.0.docx Page 26 of 56 


 


 


 


 


Adapting to your writing style (shown above) - ‘Skip this Step’ as given that Radiology Reports are unlikely to be 


contained in either e-mails or word documents this does not add anything to your overall profile. Additionally 


neither e-mail nor Word is usually installed on CRIS > PACS Workstations. 


 


Once you have completed the Set-up Dragon User – Click Finish to skip the Tutorial as this can be undertaken later. 


You should then right-click on the Microphone icon located on the task bar, followed by and ‘Tools’ then ‘Options’ 


via the Dragon Menu Bar in order to confirm that all required Dragon > CRIS configuration is correct.  


 


Refer to ‘Dragon Set-up & Configuration’ and ‘Configuring Roaming Profiles in Dragon’ for full details of correct 


configuration settings. 


 


Creating ‘Roaming’ Dragon Users 
 
***IMPORTANT PLEASE NOTE*** 
 
All Dragon users must be set up as Roaming Users to access their profiles in any location. If a user is set-up as a Local User they will only be 
able to access their profile on one terminal / workstation, and should therefore be converted to a Roaming User. 


 


There are THREE WAYS to create a roaming user: 


 


 Train a New Roaming User  


 Convert an existing Local User 


 Copy one or More Local Users 
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  To Train a ‘New’ Roaming User 
 


 Make sure that no local user is open. Click Close User on the ‘NaturallySpeaking’ menu if one is open.  


 


 Open the Administrative Settings dialog box by clicking Administrative Settings on the ‘Tools’ menu. If necessary 


select the Enable check box and make sure the network directory for the master roaming user and the local 


directory for the local roaming user are set. Click [OK].  


 


 Open either the Open User dialog box or the Manage User dialog box and make sure that the Location of user 


files box points to the network directory location of the master roaming user. If it does not, click the arrow and 


select the correct location from the list, or click the Browse button to locate the directory using the browse for 


folder dialog box.  


 


 Right-click on the Dragon menu icon > Profile > New User Profile then click the [New] button: 


 


 


 
 
 
 
 
 
 
 
 
 
 
 
 


 Then follow the on screen prompts to setup a new user in the same way mentioned in the above section ‘Setting 


up a Dragon user’ 


 


 


 


 


 


 


 


 


 


 


Please note: If you are using a Philips Speech Mike you should ensure ‘Dictation Source = USB Microphone’ 
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 It’s then time to carry out some short training. If the user is new to VR then select ‘What to expect from Speech 


Recognition’ but if the user has used VR before then select ‘Radiology Reports’ Users can also undertake 


additional Training via the Dragon Right-click menu icon > Audio > Read text to improve my accuracy. 


 


 This will usually take around 15 - 20 mins so although not recommended it is possible to skip this step and 


repeat the tutorial later. 


 


To Convert a Local User into a ‘Roaming’ User 
 


You can convert an existing local user to a roaming user with the Manage Users dialog box. 


 


 Make sure that the Roaming User feature is turned on. If a non-roaming user is open, you must close it before 


you can open the Administrative Settings dialog box. (If necessary, click Close User on the ‘NaturallySpeaking’ 


menu.)  


 


 Open the Manage User dialog box. (Click Manage Users on the ‘NaturallySpeaking’ menu.)  


 


 Use the list in the Location of user files box to select the location of the local user you want to convert to a 


master roaming user.  


 


 Select the user you want to convert.  


 


 Click the [Advanced] button and then click ‘Save’ to Roaming. The program will save the user in the location 


specified as the Network directory in the Administrative Settings dialog box.  


 


 Repeat the process for any other local users you want to convert to master roaming users.  
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To Copy ‘One or More’ Local Users into the Roaming Directory 
 


You can also copy one or more local users into the Roaming network directory, enabling you to convert a number 


of local users into roaming users within a single operation. 


 


 Double-click the My Computer icon and navigate to the location of the local user files you want to convert to 


roaming users.  
 


 Select the files you want to copy, right click, and click Copy from the shortcut menu that appears.  
 


 Navigate to the roaming network directory, right click, and click Paste from the shortcut menu that appears.  
 


Please note: This is only usually possible if you have administrator level access on the workstation. 


 


Activating CRIS and Dragon Integration 
 


Activating XR Settings 
 


Please contact your system administrator to undertake the following tasks before using Voice Recognition. 
 


ROAMING PROFILES - Before you can start using Dragon Voice Recognition within CRIS you must have set up a 


roaming user profile and completed the Dragon Voice Training.  
 


XR SETTINGS - The following XR Settings will also need to be activated at XRT (Terminal) level as this is the 


recommended level for VR.  


 


Unless otherwise advised - HSS do not recommend setting at XRS or XRTR level as only certain terminals are 


configured to use VR and any changes made to XR settings at Site or Trust level could adversely affect non VR users 


who have not disabled their VR profile. 
 


GENERAL XR SETTINGS 
 
 


 


 


 


 


VOICE.RecognitionInstalled = Yes.  


This setting is designed to activate CRIS and Dragon integration and to enable the associated functionality and 


imbedded CRIS / Dragon commands.  
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DRAGON XR SETTINGS 


 
The remaining settings should be set at XRS or XRTR level to enable these to be inherited by all subsequent 


Terminals. 


 


 


New – From CRIS 2.09.10s2 it is possible to configure the microphone reporting state: 


 
VOICE.DragonReportingStartState_AutoOFF = Sets the microphone recording state to ‘Saved’, ‘Off’, ‘On’, or 


‘Standby’ when reporting on a single event. 


  


VOICE.DragonReportingStartState_AutoON = Sets the microphone recording state to ‘Saved’, ‘Off’, ‘On’, or 


‘Standby’ when reporting using ‘Auto Select Next Exam’ via the ‘Report Info List’. 


 
Please note: It is essential to set an appropriate default value in order for dragon to be correctly enabled upon logging into CRIS. This can 
then be configured per workstation based on Radiologist requirements. If the ‘Saved’ mic configuration setting is set the recording state will 
be the same as when the mic was last used. To avoid unintended transcription HSS do not recommend the ‘Saved’ configuration option. 


 
VOICE.DragonBarAtStartup = No. Setting this to No ensures that users cannot utilise the Dragon bar since its use 


will result in a reduction in the quality of integration, or in some cases disable the features altogether. This is due 


to the fact that Dragon will attempt to work independently and ignore commands sent by CRIS and leading to 


inconsistent results when reporting. 
 


VOICE.DragonCompatibilityModule = 0,0,0,0,0,0,0,1,1 (Dragon 11). It will be necessary for existing VR users to 


amend this setting as above (i.e. 7 x 0, 2 x 1) when implementing Dragon 11. (This is set to 0,0,0,0,0,0,0,0,1 for 


Dragon 9, i.e. 8 x 0, 1 x 1). 
 


Voice.DragonKillOnStartup = No (initially). This setting ensures that any Dragon processes are killed off before CRIS 


correctly launches Dragon. CRIS must be opened before Dragon to function as required. HSS recommend that this 


setting is set to ‘YES’ once all voice profiles have been created, though this may not be required unless the Trust 


have an on-going issue with Users opening Dragon incorrectly ahead of CRIS. 


 


CONFIGURING SPEECHMIKE BUTTONS 


 
It is also possible to set the buttons on the Speechmike to perform actions within CRIS.  


 


To do this you will need to create a format called ‘BUTTONS.DRAGON’ by clicking [New] via CRIS Setup Tables > 


System > FormatEditor and entering a New Format Name = BUTTONS.DRAGON and pasting the following text into 


the format editor as follows: 


 
PLAY=CRIS:playback 


RECORD=CRIS:record 


EOL=CRIS:focus 


INSERT=CRIS:startreport 
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Having done this click [Save New Format] and proceed to configure the final Dragon XR Setting to enable this 


function. 


The following Speechmike buttons can be configured: 


 


[PLAY], [RECORD], [REWIND], [FASTFOWARD], [EOL], [INSERT] with any of the following actions:  


 


CRIS:focus 
Returns the focus to the CRIS application in the event that it is transferred to another 


application. 


CRIS:playback Starts/stops audio playback. 


CRIS:record Starts and stops recording. 


CRIS:startreport Enters the examination title, starts the report text on the next line down. 


 


VOICE.DragonButtonConfig = DRAGON. Once the BUTTONS.DRAGON format has been created you should enable 


this for use via CRIS via the XR Setting. Having appropriately configured the necessary XR Settings, you should close 


and restart the CRIS system. 


 


 


 


 


 


 


Linking CRIS and Dragon Profiles 
 


Once VR is enabled the following message will appear upon logging to CRIS:  


 


 
 


 


 


 


 


 


Clicking [Yes] will display the following ‘Open User Profile’ window and you should highlight the correct profile and 


click [Open]: 
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***IMPORTANT PLEASE NOTE*** 
 
To ensure CRIS and Dragon integration works correctly you should not load the Dragon Software independently. Consequently once all 
Dragon configuration and set-up is complete you should close Dragon completely before launching the CRIS System. 
 
The CRIS application will launch Dragon Software automatically, to ensure that CRIS is able to fully control Dragon functionality and facilitate 
full integration. You should be aware that this does mean the Dragon Bar will not, and should not be displayed. However all required Dragon 
Tools are still accessible by right-clicking the Dragon Bar Icon in the Windows System Tray.  
 


 
 
Failure to allow the CRIS System to launch Dragon will result in a reduction in the quality of integration, or in some cases disable the features 
altogether. This is due to the fact that Dragon will attempt to work independently, in effect ignoring commands sent by CRIS and leading to 
inconsistent results when reporting. 


 


Creating User Specific Text Commands 
 


Dragon Naturally speaking software allows users to set up their own commands. By setting up Text and Graphic 


commands a user can quickly and easily create standard reports.   


 


To create a new command you should go to the ‘Tools’ menu and choose ‘VR Command Browser’ which will launch 


the Dragon Command Browser. 
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To add a new command go to the ‘MyCommands’ menu and choose ‘New’: 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


Complete the fields of the ‘MyCommands Editor’ as per the following table: 
 


MyCommand Name This is the ‘Command’ you will say whilst reporting and you should therefore aim to use 


words which would not occur in everyday reporting.  


Description A description of the reporting template. 


Group Set as ‘User-Defined’. 


[Train] Click the [Train] button to train the Command Name and follow the on screen 


instructions. This step is essential for Dragon to accurately recognise your commands. 


Availability This should be ‘Global’ to ensure it can be used in CRIS. 


Command Type Text and Graphics will allow you to enter a block of text for this command. 


Content Type the text you want this command to enter into CRIS. 


  


Once you have saved the new command it can be used immediately within the CRIS application. 
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5. Dragon Vocabulary 


If you have purchased Dragon Naturally Speaking Medical you should ensure that you select and use the Radiology 


vocabulary for maximum productivity and recognition. 


 


Editing Dragon Vocabulary using the Vocabulary Editor 
 


The vocabulary editor can be used to add, edit and train individual words and phrases although this should typically 


be undertaken during the reporting process using ‘SPELL THAT’ and ‘CORRECT THAT’ functionality. If you do wish 


to access the Vocabulary Editor you will need to close CRIS and launch Dragon individually to make the required 


amendments to your vocabulary. 


 


TRAINING OR ADDING AN UNRECOGNISED / UNKNOWN WORD 
 


This is an example of how to train or add an unrecognised / unknown word for future use. Training Dragon via CRIS 


is very accurate but does not take effect until the next time CRIS is accessed since the Dragon profile is only saved 


upon exiting the CRIS client. Consequently if you intend to use the same word or phrase more than once during the 


same reporting session it is advisable to use the Dragon Vocabulary Editor. 


 


 Right click the Dragon Menu and select the VOCABULARY MENU followed by OPEN VOCABULARY EDITOR: 


 
 
 


 


 


 


 


 


 


 


- TYPE THE UNRECOGNISED / UNKNOWN WORD INTO THE [WRITTEN FORM] FIELD – i.e. 


supercalafragalisticexpialadoshus or Savage-Mady in these examples. If the word is already in the dictionary it 


will appear in the box below and you will simply need to CLICK [TRAIN] to continue: 
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 Alternatively if the word is not in the dictionary already you should also type a ‘SPOKEN FORM’ and click [ADD] 


and acknowledge and additional messages (i.e. Guess Pronunciation). You should then click [TRAIN] as normal. 


 
 
 
 
 
 
 


 
 
 
 
 
 
 
 


Please note: Any personalised Vocabulary can be identified by a RED + 


 


 Finally click [CLOSE] and right click the Dragon Menu choosing the PROFILE MENU followed by SAVE USER 


PROFILE. Adding or Training words via the Dragon Vocabulary editor enables them to be used immediately via 


the CRIS reporting module.  


 
 
 
 
 
 
 
 
 
 
 
 
 


CHANGING WORDS / CHARACTER PROPERTIES 
 


EXAMPLE 1: CHANGE THE PROPERTIES OF PARENTHESIS  


 


This example looks at changing the properties of ‘Parenthesis’ to change to the more typical term of BRACKETS.  


To make this modification: 


 


 OPEN THE VOCABULARY EDITOR via VOCABULARY MENU which is accessed via the Right Click Dragon Menu. 


 


 Type a left bracket ( into the written form box to locate the ( bracket in the dictionary. 


 
 Use [CTRL – CLICK] to highlight the LEFT AND OPEN PAREN, and RIGHT AND OPEN PAREN and click [Delete]: 
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 Type a ( left bracket into the written form box and enter ‘OPEN BRACKET’ into the spoken form field. 


 


 Click [ADD] and then click [TRAIN] and to amend the term used by Dragon for future use. 


 
 Repeat this process for CLOSE BRACKET. Explain the user can do this for LEFT and RIGHT BRACKET in future if 


required. 


 


Please note: Any personalised Vocabulary can be identified by a RED + 


 
 


 


 


 


 


 


 


 


 


 


 


 


 


 


EXAMPLE 2: CHANGING WORD PROPERTIES TO USE AN ALTERNATIVE WRITTEN FORM 


 


This example looks at modifying the properties of the word ‘to’ to control how it appears when used between 


numbers – i.e. as the word ‘to’, or as a - dash 


 


 OPEN THE VOCABULARY EDITOR via VOCABULARY MENU which is accessed via the Right Click Dragon Menu. 


 


 Type ‘to’ into the ‘Written form’ box and select [Properties] 
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 Tick ‘Use alternate written form 1’ and amend accordingly depending on your preference: 


 


    Alternative using ‘to’                  Alternative using ‘ – ‘ 


 


 
 


 


 


 


 


 


 


 


 


 


 


 
 Ensure that ‘Only use alternate written form 1’ is ticked and select ‘between numbers’ before clicking [OK]. 


 


 HSS would recommend that you also click [Train] to update your Dragon profile before saving the changes to 


your profile. 
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ADDING THE RADIOLOGY VOCABULARY TO A PROFILE 
 


If the Radiology Vocabulary has not already been chosen, it can be added to the user profile. 


 
 To do this select ‘Manage Vocabularies’ from the File Menu by right-clicking the Dragon Bar Icon in the 


Windows System Tray.   


 


 
 
 
 
 
 
 
 
 
 
 When the Manage Vocabularies Dialogue box is displayed click [New] and type Radiology as the ‘Vocabulary 


name’ and select Base Radiology – Large as the ‘Based on’ Vocabulary. Click [OK] to save this new vocabulary. 


 
  
 
 
 
 
 
 
 Having clicked [OK] the ‘Vocabulary Optimizer’ will appear. You do not need to undertake this step and should 


click [Cancel]. 
 


REMOVING VOCABULARIES FROM A USER PROFILE 
 


You may also want to remove the existing vocabulary once you have proven that the Radiology specific dictionary 


works, as it is not recommended to have more than two vocabularies per profile.   


 


You can remove vocabularies by selecting the Vocabulary you wish to delete and clicking [Delete]. 
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IMPORTING A USER SPECIFIC VOCABULARY INTO DRAGON 
 


In the previous section you created a text document that is now ready to be imported into Dragon 


NaturallySpeaking as a user specific dictionary. 


 


 Open Dragon and choose the ‘Tools’ menu - select ‘Accuracy Center’.   


 
Please note:  You must have a User ‘Open’ to be able to select ‘Accuracy Center’.  You can ‘Open’ a user from the ‘NaturallySpeaking’ menu.  
The user that is currently open will inherit the new dictionary when you import the text. 


 
 Click ‘Add words from your documents to the vocabulary’, a Add Words from Documents Dialogue box will be 


presented to you, click [Next] as follows: 


 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


 The ‘Add Words from Documents’ dialogue box will remain on screen, choose [Add Document], Browse to and 


select the CRIS_initialsofDr_dictionary.txt file you saved previously then click [Next]. 
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 Dragon will then carry out an analysis of the file (click [Next]) and will then display a dialogue box (as below) to 


enable you to decide if you would like to uncheck any words which are not frequently used. In this way you can 


choose to omit certain words in order to ensure that your own personal vocabulary is as up-to-date and context 


specific as possible. 


 


 
 
 When you have selected the words you want to include in your dictionary click [Next] and continue to click 


[Next] on all subsequent screens until the process is completed.  


 
Please note: You will be given the option to ‘train’ Dragon on the words you are adding; you can do this during this process or you can choose 
to train at a later date if necessary.  You should be advised that this process can take some time – in some cases up to 15 minutes and HSS 
therefore recommend that you undertake this process at a suitable time when the workstation is not in constant use. 
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6. Best Practice, Correction and Troubleshooting  


Input & Dictation Source 
 


It is possible to dictate using a PC Headset (supplied with Dragon License) or a Philips SpeechMike (not supplied 


with Dragon License. 


 


It is very important to choose the correct Dictation source via in the Dictation Source drop-down box when creating 


a new user. 


 


If the PC Headset has a USB connection, or you are using a USB microphone such as the Philips’ SpeechMike the 


dictation source should be set to USB Microphone. 


 


If the PC Headset does not have a USB connector it should be plugged into the standard Microphone and Headset 


ports on the workstation /terminal and the dictation source should be set to ‘Microphone Plugged into Mic Jack’. 


 


 
 
Please note: The ‘Radiology Vocabulary is only available when using Dragon Naturally Speaking Medical. 


 
 


ADDING / CHANGING DICTATION SOURCE 
 


Should you wish to add an alternative Dictation Source, or in the event that you have selected the wrong Dictation 


Source, and would like to change to a different type of Microphone you can add / change the dictation source for 


a user.  


 


 To do this select ‘Open User’ from the File Menu by right-clicking the Dragon Bar Icon in the Windows System 


Tray.   
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 Highlight the relevant User and click on the [Source] button.  


 
 


 You should then click [New] and choose the new Dictation Source (either Line-In Jack or USB Microphone) and 


click [OK] 
 


 
 
 
 
 
 
 


 


 This will create an Additional Dragon User with the correct or alternative ‘Source’ and you may therefore wish 


to [Delete] the Original User with the original ‘Source’. Alternatively it is possible to have multiple Dictation 


Sources in the event that you use different Microphone in different locations (i.e. USB on one Workstation, and 


Mic In Jack on an alternative Workstation). 
 


 Checking the Sound Quality of your Dictation Source 
 


If the source used for dictating into Dragon NaturallySpeaking is changed or if recognition seems to be impaired, 


then it is important to update the audio settings for your dictation source.   


 
 To do this right click on the bottom right Dragon icon, then hover over ‘Audio’ and select ‘Check microphone…’ 
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 This will invoke the Audio Setting Wizard where you should undertake all 3 steps to confirm / configure the 


sound quality of your dictation. Firstly, make sure the correct device is selected then precede though the steps. 


 
 


 
 
 
 
 
 
 
 
 
 


Non Dragon Users in CRIS 
 


Any CRIS user(s) working on a VR enabled Reporting Workstation, who do not wish to use Voice Recognition, or 


have not yet been trained to use Voice Recognition should click ‘No’ when prompted to select a profile when the 


user logs into CRIS for the first time on a VR enabled workstation. (Shown below) 


 


 
 
If at a later date the CRIS User wishes to begin using Voice Recognition, it is simply a case of removing the 


‘DragonUser=DRAGONDISABLED’ line from their STAFF > User Preferences to enable them to select their correct 


Dragon Profile the next time they login to the system.  


Full instructions on ‘Changing a CRIS User’s Linked Dragon Profile’ is highlighted below. 


 


Sharing VR Commands (Importing / Exporting User Commands) 
 


Dragon provides VR users with the ability to share commands either by importing, or exporting the files into specific 


user profiles, or by using the Data Distribution Tool in order to add and remove commands for all users.  


 


This is particularly useful for customers upgrading from Dragon 9.5 to 11 to facilitate exporting and importing usual 


commands. 


 


Please note: If you wish to import commands from version 9.5, it is important to retain a 9.5 installation on a workstation somewhere.  
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Exporting Specific Users Commands 
To EXPORT COMMANDS you should load the relevant user profile, and then open the command browser via Dragon 


> Tools > Command Browser 


 


 
 


You should highlight the ‘User Defined’ folder which is where users specific commands are stored, and select any 


commands that you want to export via the right hand ‘My Command’ pane. Once selected choose 'Export' via the 


left hand ‘Task Pane’.  


 


Please note: You can select multiple commands using [Ctrl + Left Mouse Click] 


 


When you click export you will be asked to choose a destination to save the exported commands before saving. 


 


Importing Specific Users Commands 
 


This file can then be imported into a specific user profiles by loading the relevant user profile within Dragon, opening 


the command browser and selecting 'import'. You should then choose the relevant file containing the exported 


commands and once the commands have been successfully imported you will see the following message: 


 


 


 


Dragon Data Distribution Tool - Importing commands to all users 
 


You will need to begin be exporting the commands as per the ‘Exporting Specific User Commands’ instructions.  


You can then use the Data Distribution Tool located via Start > Dragon Medical 11> Dragon Medical Tools > Data 


Distribution Tool. 


 


Select the 'Add or Remove shared commands' option and click [Next] before choosing the appropriate language.  
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On the following screen click [Import] and choose the exported commands file previously created which will list the 


commands in the top section of this screen. 


 


 


Having done this click [Next], this will then begin importing the commands. If roaming is enabled and is mapped on 


workstation the commands will be imported to all users on the roaming share. If roaming is not enabled then the 


commands will be passed to all users who are setup on the individual terminal. 


 


Please note: Commands can be removed from all users using the 'existing shared commands section' and selecting remove.  


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 







 
   
 
 


© Healthcare Software Solutions 2015   All Rights Reserved Commercial In Confidence 
Effective Date – ESM 05/11/2015   
HSS Doc ref:  CRIS_CRIB_VR_275_Voice_Recognition_11_V5.0.docx Page 46 of 56 


 


 


 


 


Please note: The ‘Data Distribution Location’ should be set as a location to which all Dragon users have access to allow each user to import 
the available commands. A folder should be created at the location named ‘SharedCommands’, commands placed in the folder are available 
to all users. Commands will need to be trained by each Dragon user. 
 


Correcting Voice Profiles 
 


Identifying which profile the user is linked to… 
 


When the user is logged into CRIS place the mouse cursor over the microphone icon to display which Dragon profile 


is currently loaded: 


 
 
 
 
 
 
 
 
 
 


Changing a CRIS User’s Linked Dragon Profile 
 


In the event that a user wishes to change the Dragon Profile that is linked to their CRIS User Account either due to 


a change in profile or due to error, the RIS System Manager should undertake the following course of action: 


  
 Open the CRIS Staff Table and highlight the User Account you wish to amend. 


 


 


 


 


 


 


 


 


 Click the Preferences Tab for the selected user. 


 Locate the DragonUser setting. 


 Delete this setting (Right click and Remove) and click SAVE.  


 


Please note: You should not remove the value from the preference, the ‘DragonUser’ preference should be deleted in order for this to be 
reset. 


 


 Close CRIS and Restart the application. 







 
   
 
 


© Healthcare Software Solutions 2015   All Rights Reserved Commercial In Confidence 
Effective Date – ESM 05/11/2015   
HSS Doc ref:  CRIS_CRIB_VR_275_Voice_Recognition_11_V5.0.docx Page 47 of 56 


 


 


 


 When the user logs back in to CRIS again they will be prompted to select a Dragon Profile to link to their CRIS 


User account. 


 


Disabling Windows CTFMON.exe 


 


The Nuance support and knowledge base highlights known issues where the Windows XP CTFMON.exe processes 


can interfere with Dragon often resulting in system lock up’s, freezes or problems regarding Dragon ‘Select and Say’ 


features. It is therefore recommended that this process is disabled in the event of any similar problems, since the 


CTFMON.exe is not required. 


 


Instructions on how to undertake this are available via the Nuance Support Knowledge base, and can be accessed 


directly via http://nuance.custhelp.com/app/answers/detail/a_id/2497. 


 


Anti-Virus Software 


 


When launching or using Dragon NaturallySpeaking, it is possible that third party Anti-Virus software may interfere 


with Dragon. These interferences may include dictation being blocked, or the Anti-Virus software may show an alert 


that the "natspeak.exe" process is possible malware.  


 


Cause: Dragon NaturallySpeaking connects to applications for tracking windows, text fields and dialog boxes. This 


connection may be improperly detected as an intrusion by the Anti-Virus software.  
 


Solution: To ensure that the Anti-Virus software does not interfere with Dragon NaturallySpeaking, add the Dragon 


installation directory to the Anti-Virus program's exception list.  
 


Please note: The steps for adding an exception will vary with different Anti-Virus software. Please consult the Anti-Virus program's Help File 
for the exact steps on adding an exception.  


 


The following Dragon NaturallySpeaking directories should be added as exceptions:  
 


Windows XP… 


All Files/Folders in  C:\Program Files\Nuance  


All Files/Folder in  C:\Documents and Settings\All Users\Application Data\Nuance  


All Files/Folders in  C:\Documents and Settings\[windows login account]\Application Data\Nuance  


 Windows Vista / 7… 


All Files/Folders in  C:\Program Files\Nuance  


All Files/Folders in C:\ProgramData\Nuance 


All Files/Folders in  C:\Users\Dragon\AppData\Roaming\Nuance\ 


The local cache location (if configured for a custom value and different from the above defaults). 


 


The Network shared location where the roaming user profiles are stored. 


 


Please note: If the Anti-Virus program asks whether to include all sub-folders and files to the exception list, select Yes. 


 


  



http://nuance.custhelp.com/app/answers/detail/a_id/2497
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7. Essential Housekeeping 


ACOUSTIC AND LANGUAGE MODEL OPTIMISER 
 


As you make and train corrections, train new words, use commands, and perform additional training, Dragon stores 


the acoustic and language data in an archive and uses it to enhance recognition accuracy and ‘learn’ any changes 


you have made.  


 


The Acoustic and Language Model Optimizer updates your User Profile with accumulated acoustic data from your 


corrections and any additional training you have performed as well as to add commonly used word sequences to 


the Language Model. Running the Acoustic and Language Model Optimization increases your overall accuracy. 


 


The Language Model contains statistical information that predicts which words are most likely to occur in the 


context of your speech. Language Model Optimization uses text extracted from your User Profile's .DRA files to add 


commonly used word sequences to the Language Model and .enwv (corrections) files to add amended words, 


phrases etc. 


 


HSS strongly recommend that the Acoustic and Language Model Optimiser is scheduled to run on a weekly basis in 


order to ensure that users always have access to the most up-to-date and streamlined profiles. Failure to run the 


Acoustic and Language Model Optimiser will result in a degeneration of recognition, and the appearance that 


Dragon is not learning in spite of any training undertaken by the user. 


 


Please note: Dragon will only collect this data if the correct configuration settings have been selected as detailed in this document. The 
windows scheduler is required to run the Acoustic and Language Model Optimiser. 


 


Setting up and Running the Acoustic and Language Model Optimiser 
 


HSS suggest that the ‘Acoustic and Language Model Optimiser’ is run from the server where the profiles are stored 


as this is the most time efficient as it negates network speed issues, any loss of access to profiles and should also 


be subject to the standard system backup. Dragon will need to be installed on the Roaming Profiles server using 


Remote Desktop Protocol (RDP) and can then be scheduled to run from there as per the following instructions.  


 


Please note: The roaming option (via dragon administrative Settings) will need to be disabled on the server/workstation you are running the 
Acoustic Optimiser. 


 


The ‘System Administrator’ computer can also be used to run the ‘Acoustic Optimiser’, however this may take 


longer if this is not the location of the roaming profiles. Dragon must be installed and the computer must have 


access to the roaming location.  


 


The ‘Acoustic and Language Model Optimiser’ is found via Start > All Programs > Dragon Medical 11 > Dragon 


Medical Tools > Acoustic and Language Model Optimizer Scheduler. 


 


Once the ‘Acoustic and Language Model Optimiser’ has loaded you will need to set the Roaming directory. To do 


this click [File] then [Set User Directory] and then browse to the location: 
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Once this location is set, the users’ profiles will populate the left side pane: 


 


 


 


 


 


 


 


 


Please note: It may take a while to load the profiles depending on the amount of profiles you have stored at the roaming location. 


 


Next, you will need to schedule a task to optimise a user profile. To do this click the far left icon which is highlighted 


below or choose File > New Task. You will then be prompted to enter your windows password. 


 


The next screen is where you select the profile(s) you would like to optimise and when you would like this to occur. 


 


Please note: You will need to ensure that the user profiles are not in use when you intend to run the optimizer. We advise the Acoustic and 
Language Model Optimiser is set to run out of hours to avoid this issue. 


 


Running an Initial Test 
 


HSS would recommend that you begin by setting up an initial test for one user to confirm that the process completes 


as expected, and test the speed of connection if not installed on the roaming profiles server location: 


 


 Select a User Name from the drop down list of users (select a user who will not be using their profile whilst the 


test is performed). 
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 Ensure that the top two boxes (‘Perform Acoustic Optimization’ and ‘Perform Language Model Optimization’) 


are ticked so that the acoustic and language models are both optimised. 


 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Select the ‘One Time Only’ radio button and ensure that the Start Date is today’s date and Start Time is 2-3 


minutes from the current time and click [OK] to schedule the task. 


 


The ‘Acoustic and Language Model Optimiser’ window will be displayed, ensure that the task completes 


successfully before configuring the ‘Acoustic and Language Model Optimiser’ for all user profiles. 


 


Configuring the Acoustic And Language Model Optimiser For All User Profiles 


 
Having tested the ‘Acoustic and Language Model Optimiser’ with one user profile, you can now extend this to 


cover all User Profiles.  


 


You should again ensure that the top two boxes (‘Perform Acoustic Optimization’ and ‘Perform Language Model 


Optimization’) are ticked so that the acoustic and language models are both optimised.  


 
Please note: Nuance recommend that scheduled ‘Acoustic Optimiser’ tasks do not include more than 25 user profiles. It may, therefore, be 
necessary to create more than one scheduled task depending on how many user profiles exist at your site. Tasks containing 25 profiles may 
be too large where the profiles have not been regularly optimized, in this case HSS recommend that the profiles are added to ad-hoc ‘Acoustic 
Optimiser’ tasks in smaller groups before they are added to regular scheduled tasks. 


 


 Select the users you would like to run using the [Multiple Users] function button: 
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 Add all relevant Users individually using [Add >] or [Add All >>] and click [OK] to exit this screen: 


 
 


 
 
 
 
 
 
 
 
 
 
Click [Apply] then [Ok], the ‘Acoustic and Language Model Optimiser’ window will be displayed with the scheduled 


task displayed in the right-hand side panel: 


 
 
 
 
 
 
  
Once you have scheduled the required task(s) close the scheduler and the ‘Acoustic and Language Model 


Optimiser’ will start to run when the time reaches the one specified within the ‘Next Run Time’ column.  


 


Once this has completed the ‘Last Run Time’ and ‘Last Result’ columns will be populated. The ‘Acoustic and 


Language Model Optimiser’ can take time to complete, and this varies depending on the amount of data to process. 


However the more frequently the task is run the more time efficient the process will be. 


 
Please note: Sometimes it may be necessary to refresh the window yourself by clicking on the yellow sun icon to display the result.  
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The results the ‘Acoustic and Language Model Optimiser’ can display are shown below with an explanation on each 


term: 
 


Last Result Explanation 


Success The ‘Acoustic and Language Model Optimiser’ has run successfully for the user. 


No New Data There is not enough or no new data for the ‘Acoustic and Language Model Optimiser’ to 


optimise. 


Failed The ‘Acoustic and Language Model Optimiser’ has not completed. The error should then be 


visible within the Dragon.log 


 
Please note: The ‘no new data’ result could be caused by a configuration issue, as incorrect setup can stop the required files from being 
saved. Please refer to Configuring Roaming Profiles in Dragon NaturallySpeaking to check roaming settings. 


 


Running the Acoustic Optimiser with the Windows account logged out 
 


When you schedule the Acoustic Optimiser to run out of hours and you do not wish to leave the windows account 


logged on while the Acoustic Optimiser is running, you will need to uncheck the roaming profile option in the Dragon 


administrative settings.  
 


Optimizer Questions 
 


I’m unable to schedule any task and keep encountering an error? 


We have found that if there is a corrupt profile present on your network share then the ‘Acoustic and Language 


Model Optimiser’ will prevent you scheduling a task for any user. We now have a small program which can be run 


to check for corrupt profiles. 


 


How often should the Optimizer be run on each profile? 


We recommend you run the Optimiser out of hours on a weekly basis. The more regularly you run the Optimiser 


more efficiently it will run. It has been established that monthly scheduling is not sufficient as the user profiles grow 


and degenerate over this period and the longer the gap the longer the Optimiser takes to run. 


 


  







 
   
 
 


© Healthcare Software Solutions 2015   All Rights Reserved Commercial In Confidence 
Effective Date – ESM 05/11/2015   
HSS Doc ref:  CRIS_CRIB_VR_275_Voice_Recognition_11_V5.0.docx Page 53 of 56 


 


 


 


8. Frequently Asked Questions 


 


Q. How many workstations can I log into using CRIS and Dragon VR? 


 
A. You can only be logged into one workstation at any one time when using Dragon roaming profiles. 


 


Q. What should I do if the Dragon profile does not load when logged into CRIS? 


 
A. Refer to section Changing a CRIS User’s Linked Dragon Profile. 


 


Q. How do VR Profiles become corrupted? 


 
A. Dragon profiles can become corrupted in a number of ways which are predominantly attributable to network 


failures or user error as follows: 


 


 The disk where the profiles are stored becomes full which will corrupt all profiles. 


 


 The profile did not save fully to the roaming profile folder – i.e. Due to network pauses or most commonly users 


turning off the PC without closing applications safely. 


 


 The same user logged into more than one terminal, as Dragon profiles cannot be loaded in more than one 


location. 


 


 Using someone else’s windows network login as it can’t sync with your own profile. 


 


If you experience corrupted profiles corruptions you should contact the HSS Helpdesk for guidance on restoring 


profiles, which may involve providing the Dragon.log which is located in 


C:\Users\UserName\AppData\Roaming\Nuance\NaturallySpeaking11. 


 


Q. Why can’t I access the Command Browser from the Dragon right-click menu? 


 
A. The Command Browser can now be found within CRIS under the Tools option. Refer to section Creating User 


Specific Text Commands. 


 


Q. Why does it sometimes appear that Dragon does not learn my new words and phrases correctly? 


 
A. There are two potential reasons for this as follows: 


 
 Training Dragon via CRIS is very accurate but does not take effect until the next time CRIS is accessed since 


the Dragon profile is only saved upon exiting the CRIS client. Consequently if you intend to use the same 
word or phrase more than once during the same reporting session it is advisable to use the Dragon 
Vocabulary Editor. Refer to 9.1 - Editing Dragon Vocabulary using the Vocabulary Editor. 
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 The acoustic and language model optimiser needs to be routinely undertaken to optimise the user’s 
vocabulary files. Refer to the What is the Acoustic and Language Model Optimiser?  of this document 


 


Q. What if the microphone volume is too low while reporting? 


 
A. This often occurs when the Workstation is used for both digital dictation and voice recognition. The microphone 


will need to be re-calibrated. This can be accessed from the right-click Dragon Menu via Audio and the ‘Check 


Microphone’. Refer to 10.3 - Checking the Sound Quality of your Dictation Source. 


 


Q. Why does Dragon keep prompting me to check the Mic, once it has already been configured on the 
workstation? 
 


The first time a roaming user logs on to a workstation Dragon will ask to configure the Mic settings. If you continue 


to be prompted to check the Mic on subsequent session using the same workstation, Dragon does not have the 


correct permissions to the local roaming folder and the changes are not being saved, which means customs 


commands will not be saved either.  


 


The most likely scenario is they do not have inherited modify permission’s to the local roaming folder so the 


microphone training is not being saved and for custom commands, Dragon cannot write to the mycmds.dat file 


where all the commands are kept.  The folder could have modify permissions but if not set to inheritance all child 


folders and files (i.e. mycmds.dat) will only be read and execute – Refer to 4.2. - Configuring Roaming Profiles in 


Dragon NaturallySpeaking. 


 


Please note: This will occur if the Speechmike is routinely unplugged and reinserted into different USB ports on the machine (i.e. A Laptop) 
as Dragon will validate the windows plug and play device on each occasion. 


 
 


Q. Why do some profiles corrupt when using dragon roaming profiles across multiple sites? 
 


If you are experiencing roaming profile corruption for users who are reporting across multiple sites (and the profile 


share is in a single location) you can tick the ‘Access network at user profile open/close only’ via the dragon 


‘Administrative Settings’ roaming tab. When this option is ticked Dragon will only connect and synchronise data 


only when it opens and closes, rather than synchronising regularly. If you are still experiencing profile corruptions 


after making this change. Please notify the HSS helpdesk for support. 
 


Q. Why do some radiology reports appear abridged when viewed in PACS / PACS / OCS? 
 


HSS recommend that Clinical Reports should only include ASCII character sets and should not include any non–


printable control characters outside of the standard A-Z, a-z, 0-9. Additionally, when dictating clinical reports please 


do not make use of either ~ Tilde or | Pipe/Vertical Bar symbols as these characters are used as Field delimiters in 


HL7 interfaces. Field delimiters separate data fields – i.e. When PACS/PAS/OCS interfaces receive messages from 


CRIS they use HL7 Field delimiters to parse data into the correct fields 


 


HSS has also established that the ‘–’ (extended dash) symbol is treated as an illegal character via HL7 interfaces (as 


it is classed as a Unicode Carriage Return) and this results any text after this character being rejected by the interface 


– (i.e. partial or abridged reports). 
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You should therefore ensure that dash, N Dash and M dash are deleted from the User Vocabulary. It is then possible 


to [Add] ‘-’ dash back into the vocabulary and [Train] if required or simply make use of the hyphen instead. 
 
 
 


 


 
 
 
 
 
 
 
 
 
 
 
 
 
 


Q. Why don’t my ‘VR Command Browser’ report templates work when looking at images in PACS? 
 


In order to use templates which have been created in the ‘VR Command Browser’ the focus must be within the 


‘Report Editor’ within the CRIS application. It is common for the application focus to be moved to PACS when images 


are viewed/manipulated, the focus needs to be returned to CRIS in order to use the template. 


 


The focus can be returned to the CRIS application using the mouse to click back into the CRIS Report Editor or a 


button on the Speechmike can be configured to return the focus to the CRIS application, see the section on buttons 


configuration within this document. 
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11..  IInnttrroodduuccttiioonn  
 


Purpose and Scope 


 
This document is aimed at sites that are in the process of implementing, or have already implemented the CRIS 
Radiology Information System with integrated Dragon 12 Practice Edition Voice Recognition (VR) software.  


It aims to introduce the main features of the Dragon 12 software and to deploy this functionality to improve 
efficiency and enhance reporting workflows in a modern RIS / PACS environment. 
 
These areas are: 
 


 Sections relevant to IT Personnel / PACS Engineers 


 Overview of CRIS / Dragon Integration 


 Dragon Medical 12 System Requirements 


 Important Considerations 


 Related User Documentation 


 Installation and Setup 


 Dragon Setup & Configuration 


 Roaming Profiles 


 Creating a Dragon User for Setup 


 Creating Roaming Dragon Users 


 Activating CRIS and Dragon Integration 


 Creating User Specific Text Commands 


 Best Practice, Correction and Troubleshooting 


 General Housekeeping 


 Frequently Asked Questions 


To get the most out of the integration between CRIS and Dragon, it is essential that the configuration of Dragon 
should be undertaken as described within this document. 
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 Audience 


 


This document is aimed at HSS CRIS customers who have Dragon NaturallySpeaking 12.  
 
It is designed to be used by RIS/PACS Administrators and/or IT support personnel. This document is also available 
for reference by PACS Workstation Engineers. 
 


Sections relevant to IT Personnel / PACS Workstation Engineers 


 
The installation process will require a local account with administration level rights, and it may be necessary to 
contact your PACS provider to install the Dragon Software on PACS workstations if you do not have workstation 
administrator rights. 
 
Any IT Personnel or PACS Workstation Engineers who have been tasked to install the CRIS client and Dragon 
Software should refer to the following sections. This information should also be reviewed by RIS / PACS Managers 
tasked to support the Dragon product in the department. 
 


DESCRIPTION PAGE 


DRAGON 12 SYSTEM REQUIREMENTS 7 


INSTALLATION AND SETUP 12 


INITIAL SETUP AND INSTALLATION (APPLYING DEFAULT SETTINGS TO ALL USERS) 12 


MODIFYING EXISTING INSTALLATIONS (APPLYING DEFAULT SETTINGS TO ALL USERS) 14 


DRAGON SET UP & CONFIGURATION 19 


ROAMING PROFILES 22 


CONFIGURING ROAMING PROFILES IN DRAGON NATURALLYSPEAKING 23 


CREATING A DRAGON USER FOR SETUP 26 


ACTIVATING CRIS AND DRAGON INTEGRATION 35 


ACTIVATING XR SETTINGS 35 


LINKING CRIS AND DRAGON PROFILES 37 


ESSENTIAL HOUSEKEEPING – SETTING UP AND SCHEDULING THE ACCOUSTIC OPTIMISER 53 


 


Upgrading to Dragon 12  


 
See the following sections in this document for information on the upgrade process to Dragon version 12: 
 


DESCRIPTION PAGE 


UPGRADING TO DRAGON VERSION 12 16 


TO UPGRADE VOICE PROFILES TO DRAGON 12 32 
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22..  OOvveerrvviieeww  ooff  CCRRIISS  aanndd  DDrraaggoonn  IInntteeggrraattiioonn  
 
Dragon NaturallySpeaking 12 Medical provides a powerful voice recognition system which has been fully 
integrated to the HSS CRIS system in order to facilitate the rapid transcription of comprehensive clinical reports.  
 
Dragon NaturallySpeaking 12 software incorporates a comprehensive vocabulary of medical words and phrases 
including a Radiology dictionary that enables Dragon to recognise complex medical terms, and also develop and 
learn in context to the individual user’s vocabulary, and dragon voice profile. 
 
Please note: Dragon improves by recording data and storing all spoken words and phrases in context to the user, and by optimizing the 
data regularly when used in conjunction with the essential Dragon utility the ‘Acoustic and Language Model  Optimizer’ which should be 
run weekly for the best result in terms of recognition and maximum productivity. 


 


Dragon 12 System requirements 
 


Minimum System Requirements: 
 
 CPU: 1 GHz Intel Pentium or equivalent AMD processor, or 1.66 GHz Intel Atom processor. 
 Note: SSE2 instruction set required. 
 Processor Cache: 512 KB 
 Memory (RAM): 1 GB for Windows XP and Windows Vista, 2 GB for Windows 7, Windows 8 and Windows 


Server 2008. 
 Free hard disk space: 3.2 GB (4 GB for localized non-English versions) 
 Supported Operating Systems: 
 Windows 8 (32-bit and 64-bit Editions) (Windows 8.1 w/ Dragon 12.5.1) 
 Windows 7 Service Pack 1 (32-bit and 64-bit Editions) 
 Windows Vista Service Pack 2 or higher (32-bit and 64-bit Editions) 
 Windows XP Service Pack 3 or higher (32-bit only Edition) 
 Windows Server 2008 Service Pack 1 or Service Pack 2 (32-bit and 64-bit Editions) 
 Windows Server 2008 R2 Service Pack 1 or higher (64-bit only Edition) 
 DVD-ROM drive (required for installation). 
 Microsoft Internet Explorer 7 or higher   
 
Recommended Specifications: 
 
 CPU: Intel Pentium 2.2 GHz (dual 1.8 GHz core processor) or equivalent AMD processor. 
 Note: SSE2 instruction set required. 
 Processor Cache: 2 MB 
 Memory (RAM): 2 GB RAM or more for Windows XP Windows Vista, Windows 7 (32-bit), Windows 8 (32-bit) 


or Windows Server 2008 (32-bit).  4 GB or more for Windows 7 (64-bit), Windows 8 (64-bit) and Windows 
Server 2008 (64-bit). 
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 Important Considerations 
 


CRIS > DRAGON INTEGRATION 


 
It is very important that you DO NOT open Dragon NaturallySpeaking independently on a workstation when CRIS 
is running with VR integration turned on.  You must ensure CRIS is not running before you start Dragon 
NaturallySpeaking to perform any administrative tasks on profiles/users. 
 
Within normal day to day use CRIS will be used to start and close the Dragon NaturallySpeaking software.  Dragon 
should not be opened separately when CRIS is running.  
 
You should be aware that this does mean the Dragon Bar will not, and should not be displayed. However all 
required Dragon Tools are still accessible by right-clicking the Dragon Bar Icon in the Windows System Tray.  
 
 
 


 
 
 
 
 
 
 
Failure to allow the CRIS System to launch Dragon will result in a reduction in the quality of integration, or in 
some cases disable the features altogether. This is due to the fact that Dragon will attempt to work 
independently, in effect ignoring commands sent by CRIS and leading to inconsistent results when reporting. 
 


CORRECTLY CONFIGURING DRAGON ROAMING 


 
The most common cause of incidents reported to the HSS helpdesk relate to incorrect setup / configuration of 
Dragon roaming profiles. This is typically due to the following issues: 
 
 When setting up the roaming profiles via Dragon Administrative Settings. The network path where the 


Roaming Dragon voice profiles are stored must be either a persistent mapped drive or a full network UNC 
‘'Universal Naming Convention' path to where the user Dragon roaming profiles are to be stored (i.e. 
\\servername\Dragonprofiles). 


 An IP address in the roaming network path in the Dragon Administrative Settings is not supported by Dragon. 
Only a mapped drive or full UNC path can be used. 


 When creating the folder for both the network location and the local directory for cache folder in the 
administration settings, it's recommended to use a short name with no spaces. For example 
\\username\vrprofiles and not \\servername\ Dragon users profiles folder. 


 Dragon does not backup roaming profiles. The roaming profiles will need to be stored on a share that is 
backed up regularly.  


 Dragon must be installed using a windows account with Administrator rights not the actual Local 
Administrator account which should be disabled. 
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  The roaming profiles must not be created using an Administrator account. They need to be created with the 
same user rights as the users who will use the profile and they must have the correct modify NTFS 
permissions to the profile folder. The administrator must not be the owner of the folder. 


 For sizing HSS would recommend 2GB per user, although typically the profile size is between 500MB – 1GB. 


 
Full details regarding setting up and configuring Dragon Roaming correctly is contained in section 4 - Roaming 
Profiles. 
 


SETTING UP / SCHEDULING THE DRAGON ACCOUSTIC LANGUAGE & MODEL OPTIMISER 


 
As you make and train corrections, train new words, use commands, and perform additional training, Dragon 
stores the acoustic and language data in an archive and uses it to enhance recognition accuracy and ‘learn’ any 
changes you have made.  
 


HSS strongly recommend that the Acoustic and Language Model Optimizer is scheduled to run weekly in order to 
ensure that users always have access to the most up-to-date and streamlined profiles. Failure to run the Acoustic 
and Language Model Optimizer will result in a degeneration of recognition, and the appearance that Dragon is not 
learning in spite of any training undertaken by the user. 
 


HSS also suggest that the Acoustic and Language Model Optimizer is run from a server where the profiles are 
stored as this is the most time efficient in terms as it negates network speed issues, any loss of access to profiles 
and should also be subject to the standard system backup.  
 


Consequently, it is essential that the Acoustic and Language Model Optimizer is set up and scheduled to run as 
soon as CRIS > Dragon Voice Recognition is in use in order to ensure that successful running of the modules 
throughout the life of the system. 
 
Full details regarding setting up and configuring the Acoustic Optimizer and Language Model is contained in 
section 11 - Essential Housekeeping. 
 


IGNORING / UNINSTALLING PHILIPS SPEECHMIKE DEVICE CONTROL SOFTWARE 


 
If the Trust have opted to purchase or use existing Philips SpeechMike’s as an alternative to the recommended VR 
Headset you should ensure that you do not install Philips SpeechMike Device Control Software. HSS have 
identified that CRIS > Dragon VR will not function as expected if Philips SpeechMike Device Control Software are 
installed.  
 
This is particularly in relation to the behavior of the record button. You should not install any software supplied 
via media with the Philips SpeechMike. The device should only be installed using USB plug and play when in use 
with the CRIS > Dragon integration. 
 
Alternatively, if you (or IT) have already installed the Philips SpeechMike Device Control Software, you should 
uninstall this completely, otherwise HSS cannot guarantee the correct operation of the Philips SpeechMike when 
used in conjunction with the CRIS > Dragon integration. 
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 Related Documentation 
 


CRIS > DRAGON DOCUMENTATION 


 


The following additional CRIS > Dragon Documentation is designed to be used in conjunction with this document: 
 


CRIS_CRIB_VR_292_Dragon_12_Using_Voice_Recognition.doc- Overview of using CRIS with the integrated 
Dragon Voice Recognition and in-built CRIS commands aimed primarily at End Users. 
 


DRAGON DOCUMENTATION 


 


HSS would also recommend that customers make use of the official Dragon documentation and knowledge bases 
as this is an invaluable source of information for IT and Dragon Users alike. 
 
 


Dragon Medical IT Administrators Guide 
 


Accessed via Start Menu > Dragon Medical Tools > Dragon Medical IT Administrators Guide this section of the 
system provides technical details regarding Dragon Setup and Configuration. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


Dragon NaturallySpeaking Help 
 


Searchable Basic Help on all aspects of using Dragon NaturallySpeaking – accessed by right-clicking the Dragon Bar 
Icon in the Windows System Tray. 
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Please note: You should be advised that the Dragon Bar is not for use in conjunction with CRIS integration. 


 


On-line Support and Knowledge Base  


 
The ‘Nuance’ on-line Support and Knowledge base also provides a comprehensive, interactive source of 
information regarding usage, configuration, and troubleshooting in addition to known issues and future 
resolutions. 
 
This can be accessed via http://nuance.custhelp.com/app/utils/login_form/redirect/account%252Foverview 
where it will be necessary to create an account using your product serial number. 
 



http://nuance.custhelp.com/app/utils/login_form/redirect/account%252Foverview
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33..  IInnssttaallllaattiioonn  aanndd  SSeettuupp  
 


Initial Setup and Installation (Applying Default settings to ALL Users) 


 
Dragon software can be configured per Individual Profile using the ‘Typical’ Installation. However HSS strongly 
recommend that the ‘Custom’ Installation is used as standard since this allows the Trust to configure default 
required settings for ALL Users ensuring Dragon is correctly configured and does not need to be configured per 
user. 
 
Please note: If Dragon has already been installed at an earlier date, it is also possible to modify the installation of Dragon to set the default 
settings for ALL users retrospectively. Please proceed to 2.2 – Modifying Existing Installations for full details. 


 


1. Insert the DVD for Dragon NaturallySpeaking, the following dialogue box will appear. Click [Next] to continue 
to Step Two. If the installation does not start automatically, use ‘Windows Explorer’ to find and double-click 
setup.exe on the DVD. 


 


 


 


 


 


 


 


 


 


 


 


 
2. Select Custom from the Setup Type Menu and click [Next] 
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 3. Nothing needs to be changed on the screen below. Click [Next] 


 


 


 


 


 


 


 


 


 


 


 


4. Ensure that you have ticked ‘Modify the application’s settings for all users’ and ‘modify the administrative 
settings’ via the Custom Setup menu before clicking [Next]. 


 


 


 


 


 


 


 


 


 


 


 


 


5. Follow the on screen prompts to complete the installation.  


Once the installation is completed the Options configuration menu will appear to enable you to set default 
options for ALL Users.  


Proceed to DRAGON SETUP & CONFIGURATION for details of applying all recommended settings for Dragon 
within the CRIS Application. 


Having undertaken all recommended configuration via the Options menu this will be followed by the 
Administrative Settings which enables you to configure Roaming Profile Setup for ALL USERS. It is therefore 
important to ensure that the shared volume where the dragon voice profiles are to be stored is correct  
 
Proceed to CONFIGURING ROAMING PROFILES IN DRAGON NATURALLYSPEAKING for full details. 
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 Modifying Existing Installations (Applying Default settings to ALL Users) 


 


It is also possible to modify the default settings for ALL USERS even in the event that the Dragon Software has 
already been installed on a terminal / workstation.  
 
HSS strongly recommend that this is undertaken on all terminals running Dragon in order to ensure that ALL 
USERS have the correct configuration to ensure optimum usage and dictionary adaptation in conjunction with the 
CRIS system. 
 


 Insert the Dragon NaturallySpeaking Installation DVD and use ‘Windows Explorer’ to find and double-click 
setup.exe on the DVD. 
 


 The following dialogue box will appear. Click [Next] to continue: 
 


 


 


 


 


 


 


 


 


 


 


 


 Select Modify from the following programme maintenance menu and click [Next]: 


 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


 


 Nothing needs to be changed on the screen below. Click [Next]: 
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 Ensure that you have ticked ‘Modify the application’s settings for all users’ and ‘Modify the administrative 
settings’ via the Custom Setup menu before clicking [Next]: 


 


 


 


 


 


 


 


 


 


 


 


 
An additional configuration menu will briefly appear followed immediately by the Options configuration menu to 
enable you to set default options for ALL Users.  
 
Proceed to DRAGON SETUP & CONFIGURATION for details of applying all recommended settings for Dragon 
within the CRIS Application. 
 
Having undertaken all recommended configuration via the Options menu this will be followed by the 
Administrative Settings which enables you to configure Roaming Profile Setup for ALL USERS. It is therefore 
important to ensure that the shared volume where the dragon voice profiles are to be stored is correct  
 
Proceed to CONFIGURING ROAMING PROFILES IN DRAGON NATURALLYSPEAKING for full details. 


 


  


  







 


© Healthcare Software Solutions 2016  All Rights Reserved Commercial In Confidence 
Effective Date – ESM 30/03/2016   
HSS Doc ref:  CRIS_CRIB_VR_276_Voice_Recognition_12_v6.0.doc Page 16 of 61 


 


 


 Upgrading to Dragon 12 from a Previous Version 


 
If you are upgrading from a previous version of Dragon you should ensure that any existing roaming dragon voice 
profiles are upgraded before running the upgrade in order to use them in Dragon 12. See the ‘To upgrade a 
Roaming profile from a previous Dragon version’ section of this document. 
 
Version 10.x or above of Dragon can be upgraded to Dragon 12. Upgrading from Dragon version 9.x or earlier is 
not supported. To upgrade from Dragon version 10 or above: 
 


 Run the setup.exe for Dragon 12 and follow the install instructions. When the installation starts, you will 
receive the following message: 


 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


 Select the ‘Remove all existing versions and continue the installation’ check box and click the [Next] button. 
 


 Select Custom from the ‘Setup Type’ Menu and click [Next]. 
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 Please note: When upgrading, Dragon will automatically carry over the settings from the previous installation of Dragon, please still follow 
the steps in the ‘Dragon Setup & Configuration’ section of this document to ensure that your Dragon configuration settings are set to the 
recommended settings for Dragon to work correctly in CRIS. 


 


 Nothing needs to be changed on the screen below. Click [Next] 


 


 Ensure that you have ticked ‘Modify the application’s settings for all users’ and ‘modify the administrative 
settings’ via the Custom Setup menu before clicking [Next]. 


 


 


 


 


 


 


 


 


 


 


 


 


Please follow the on screen prompts to complete the installation.  


Upgrade considerations 


 
You cannot upgrade to Dragon Medical Practice Edition 2 if your current license is for any of the non-medical 
versions of Dragon Medical.  If you upgrade a computer from a previous version of Windows to Windows Vista or 
Windows 7, and that computer has Version 8.x, 9.x, or 10.x of Dragon installed, that version of Dragon will not 
work after upgrading to Windows Vista or Windows 7. All your Dragon voice profiles from Dragon version 10+ will 
remain intact and can be upgraded after you have installed Dragon NaturallySpeaking 12. 
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 Updating Dragon 12 Practice Edition 


 
Once you have finished installing Dragon 12, the next task is to install the latest update.  
 


 To install the update, open Dragon and close the (open user profile) box. Click help and (check for update) 
from the Dragon bar and the following box will appear. An internet connection is required.  


 
Please note: The update can also be downloaded and installed later if required. 


 


 


 


 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


 Next click the tick box for the service pack and select the install button and the update will start to download. 
Once downloaded, click the next button and then the update button and the update will install. 


 


 Click [Yes] to closing Dragon. 
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 Dragon Setup and Configuration 
 


This section describes the ‘Options’ menu changes required for using Dragon with CRIS.  The ‘Options’ menu will 
be displayed automatically when undertaking a Custom installation, or Modifying an Existing installation, or can 
be accessed via an Existing User by right-clicking on the Microphone icon located on the task bar and selecting 
‘Tools’ then ‘Options’ via the Dragon Menu Bar. 


 


Essential Dragon Configuration Settings 


 


The following screen-shots show the required Dragon Options Menu Configuration which must be applied 
correctly in order to ensure correct CRIS > Dragon Integration. Only Tabs / Screens which require modification are 
shown. Dragon MUST BE installed / configured using a Custom installation to ensure you can ‘Modify the 
Applications Setting for All Users’ (See Section Initial Setup / Installation, or Modifying an Existing Installation). 
HSS recommend you confirm that the setup is correct before proceeding to using Dragon VR on any workstation. 


CORRECTION MENU 
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 COMMANDS MENU 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


VIEW MENU 
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 MISCELLANOUS MENU 


 


Please note: The ‘Speed vs Accuracy’ setting is greyed out as this setting is for individual profiles and not for all users. 


DATA MENU 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


Please note: The option to ‘Store corrections in archive’ will determine whether or not a list of the user’s corrections will be stored for later 
use by the Acoustic and Language Model Optimizer (Having this turned OFF does not stop Dragon doing its normal adaptation and 
correction for the user). Click the Archive Size button to check the archive size is set to the standard default of 180 minutes of stored 
corrections. If this option is not selected before you run the Acoustic and Language Model Optimizer, you may see a message that there is 
not enough data for the Acoustic and Language Model Optimizer to process. This option should be enabled whenever Dragon 
NaturallySpeaking is used for an extended period of time.  



mk:@MSITStore:C:/PROGRA~1/Nuance/NATURA~1/help/enx/power/dragon_enx.chm::/dictate/about_acoustic_optimizer.htm
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44..  RRooaammiinngg  PPrrooffiilleess  
 


How Roaming Profiles work 


 


The Roaming User feature in Dragon NaturallySpeaking lets you dictate at different locations connected to your 
network, without having to create and train individual user files at each location. Dragon roaming is essential if 
the Radiologists use more than one terminal to allow users to access their personal files/dictionary at any 
workstation. 
 
The ROAMING DIRECTORY is just a standard windows folder which HSS would recommend is named ‘Dragon 12’ 
on a local shared network location anywhere the Trust IT chooses to set it up. HSS strongly recommend that this 
location is covered by the standard backup processes undertaken on a routine basis at Trust. For sizing HSS would 
recommend 2GB per user, although the typical profile size is 500MB – 1GB. 
 
Roaming Profiles are handled using either a networked UNC 'Universal Naming Convention' path or a shared 
network drive which all users can access. If using a mapped drive this drive needs to be mapped as a persistent 
connection to each end user machine.  All users have their profile data saved centrally in this 'mapped' network 
drive so you will need to know the drive letter associated with this drive and any passwords needed to access it in 
order to configure this feature. 
 


ESSENTIAL CONFIGURATION - DRAGON ROAMING PROFILES 


 


The following guidelines should be followed when creating and configuration Dragon roaming profiles as failure 
to do will cause issues when the Dragon application, and is by far the most common cause of VR issues reported 
via the HSS Helpdesk. 


 When setting up the roaming profiles via Dragon Administrative Settings. The network path where the 
Roaming User profiles are stored must be either a persistent mapped drive or a full network UNC ‘'Universal 
Naming Convention' path to where the user Dragon roaming profiles are to be stored (i.e. 
\\servername\Dragonprofiles). 


 An IP address in the roaming network path in the Dragon Administrative Settings is not supported by Dragon. 
Only a mapped drive or full UNC path can be used. 


 When creating the folder for both the network location and the local directory for cache folder in the 
administration settings, it's recommended to use a short name with no spaces. For example 
\\servername\vrprofiles and not \\servername\Dragon users profiles folder. 


 Dragon does not backup roaming profiles. The roaming profiles will need to be stored on a share that is 
backed up regularly.  


 Dragon must be installed using a windows account with Administrator rights not the actual Local 
Administrator account which should be disabled. 


 The roaming profiles must not be created using an Administrator account. They need to be created with the 
same user rights as the users who will use the profile and they must have the correct modify NTFS 
permissions to the profile folder. The administrator must not be the owner of the folder. 


 For sizing HSS would recommend 2GB per user, although the typical profile size is 500MB – 1GB. 
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 Configuring Roaming Profiles in Dragon NaturallySpeaking 


 
The ‘Administrative Settings’ menu will be displayed automatically when undertaking a Custom Installation, 
Modifying an Existing Installation, or can be subsequently accessed by right-clicking the Microphone icon located 
on the task bar and choosing the ‘Tools’ menu  followed by the ‘Administrative Settings’ option via the Dragon 
Menu Bar. 


You must close any active users in order to access this panel. You can close Users from the main 
'NaturallySpeaking' menu or by right-clicking on the Microphone icon located on the task bar. 


Please note: If upgrading from a previous version of Dragon uncheck the roaming ‘Enable’ tick box. The ‘Enable’ tick box should remain 
unchecked until all profiles have been upgraded to Dragon version 12 profiles. Once you have upgraded all your Dragon voice profiles, you 
can then re-tick the enable roaming profiles. 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


Please note: The above administrative settings must be set correctly on each terminal for .DRA (Acoustic Dragon files) to be created for 
each session. These DRA files are needed by the Acoustic and Language Model Optimizer. The Acoustic and Language Model Optimizer 
must be installed and configured as per the Essential Housekeeping Instructions to ensure that Dragon continues to work as effectively an 
accurately as possible. 


 


Within the 'Administrative Settings' panel there are two main settings on the Roaming tab: 


 Network directory  


 Local directory  
 


NETWORK DIRECTORY 


 
This is the location(s) of the master Roaming User files.  You should add either a full UNC ‘Universal Naming 
Convention' path or a mapped drive followed by the directory in which you would like the profiles to go.  
(W:\Dragon12 is an example - If you do not have a directory created on your shared drive you will need to make 
one and ensure that it has ‘modify’ permissions for all the required users.) 
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 LOCAL DIRECTORY 


 
This is the location where the roaming local profile will be created for each user while they are working which will 
synchronise to the roaming master profile on the server. The master profile on the server is always the most up to 
date version, so a user can logon to any Dragon workstation and their changes will always be the most current 
data. 
 
This includes the following files: 
 .DRA files (Dragon Acoustic data) - Dragon is an audio application and it creates many large audio files called .DRA files. These can 


become very large in size as Dragon records every word the user says for learning and accuracy and stores it in these .DRA files. 


 MyCommands.dat file - All Dragon commands including custom commands. 


 Any changes to the local profile including - Phrases, Training, Mic Configuration etc.  


 
This is typically saved via C:\users\username\appdata\roaming\nuance\naturallyspeaking12. 


 


New IMPORTANT CONFIGURATION REQUIREMENTS – AMENDING LOCAL CACHE DIRECTORY 


 
HSS recommend that you amend the default local directory for ease of administration and troubleshooting. You  
should therefore create a ‘Dragonprofiles’ directory via the C:\cris3 folder as this ensures that the user has the 
correct NTFS permissions to write to this folder as this is where all changes to roaming profiles will be stored 
before being transmitted to the roaming profile directory.  
 


 


MISCELLANEOUS TAB 
 


The Miscellaneous Tab is where you will find settings for the Backup Location of User Files and will need to be 
amended as per the following screenshot: 
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 BACKUP LOCATION FOR USER FILES 


 
This option can be left as the default as it is important to note that Dragon does not automatically backup any 
profiles when using roaming profiles. The backup settings are designed to specify where manual back-ups should 
be saved if invoked by the user themselves. You can choose to modify the default location but this will continue 
to be a manual task. HSS therefore strongly recommend that you ensure the Main Roaming Directory containing 
the master roaming profiles is covered by the standard backup processes undertaken on a routine basis at Trust.  
 


SCHEDULED TASKS TAB 


 
The Scheduled Tasks Tab is where you should ensure that the ‘Enable Scheduled Accuracy Tuning’ and ‘Let the 
User choose when to run the Accuracy Training and Data Collection’ should be disabled in favour of a centralised 
Acoustic and Language Model Optimizer which is scheduled to run weekly to maximise VR accuracy and 
productivity.  


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


Please refer to the ‘Essential Housekeeping Section’ of this guide for more information on the Acoustic 
Optimizer. 
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55..  CCrreeaattiinngg  aa  DDrraaggoonn  UUsseerr  ffoorr  SSeettuupp  
 


When installing Dragon for the first time it will be necessary to create a local ‘Setup User’ to test that the options 
and roaming profiles are correctly configured ahead of adding subsequent users. 


You should therefore install the Dragon software as directed via Sections 2 and 3 and create a local ‘Setup User’ 
as directed below ensuring that you click ‘Skip initial training of this user’.  


It is possible to dictate using a Headset (supplied with Dragon License) or a Philips SpeechMike (not supplied with 
Dragon License). The screens below will show how to set up a user. 


You will be asked to enter a range of information including a name for the profile, profile location (this will default 
if roaming is enabled) age, vocabulary (Radiology), accent and audio source. It will then give you chance to review 
your choices. (Shown below) 


  


Please note: If you are using a Philips SpeechMike you should ensure ‘Dictation Source = USB Microphone’. 
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 Please note: If the microphone is held too closely to the user’s mouth the voice sample may not be recognised (the bar on the right-hand 
side of the screen will not move when then text is being read) which may adversely affect the recording volume for voice recognition. 
When completing the volume check you should ensure the volume bar is active and is therefore recognising the voice sample. 


 


Adjust Microphone – Volume Check 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


Adjust Microphone – Quality Check 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


Please note: If the Quality Check fails you should check all connections of dictation kit, that no sound settings are on mute and if there is 
anything that can be done to minimise background noise – i.e. closing the office door. The volume and quality check will also need to be 
completed at least once at each workstation the user will use to report. This can be done at any time by right clicking on the bottom right 
Dragon icon then audio and check microphone. 
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Adapting to your writing style (shown above) - ‘Skip this Step’ as given that Radiology Reports are unlikely to be 
contained in either e-mails or word documents this does not add anything to your overall profile. Additionally 
neither e-mail nor Word is usually installed on CRIS > PACS Workstations. 


Once you have completed the Setup Dragon User – Click Finish to skip the Tutorial as this can be undertaken later. 
You should then right-click on the Microphone icon located on the task bar, followed by and ‘Tools’ then ‘Options’ 
via the Dragon Menu Bar in order to confirm that all required Dragon > CRIS configuration is correct.  


Refer to Dragon Setup & Configuration and Configuring Roaming Profiles in Dragon for full details of correct 
configuration settings. 
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66..  CCrreeaattiinngg  ‘‘RRooaammiinngg’’  DDrraaggoonn  UUsseerrss  
 


***IMPORTANT PLEASE NOTE*** 
 


All Dragon users must be set up as Roaming Users to access their profiles in any location. If a user is set up as a 
Local User they will only be able to access their profile on one terminal / workstation, and should therefore be 
converted to a Roaming User. 


 
There are FOUR WAYS to create a roaming user: 


 Train a New Roaming User  


 Convert an existing Local User 


 Copy one or More Local Users 


 Upgrade a Roaming profile from a previous Dragon version 


 


  TO TRAIN A ‘NEW’ ROAMING USER 
 


 Make sure that no Local User is open. Click Close User on the ‘NaturallySpeaking’ menu if one is open.  
 


 Open the Administrative Settings dialog box by clicking Administrative Settings on the ‘Tools’ menu. If 
necessary select the Enable check box and make sure the network directory for the master Roaming User and 
the local directory for the local Roaming User are set. Click [OK].  


 


 Open either the Open User dialog box or the Manage User dialog box and make sure that the Location of user 
files box points to the network directory location of the master roaming user. If it does not, click the arrow 
and select the correct location from the list, or click the Browse button to locate the directory using the 
browse for folder dialog box.  


 


 Choose the ‘File’ menu via the Dragon Menu Bar or by right-clicking on the Microphone icon located on the 
task bar. Click’ New User Profile and then [New] 
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  Then follow the on screen prompts to set up a new user in the same way mentioned in the above section 
‘Setting up a Dragon user’. 


 


 


 


 


 


 


 


 


 


 


 


Please note: If you are using a Philips SpeechMike you should ensure ‘Dictation Source = USB Microphone’ 


 


 


 


 


 


 


 


 


 


 


 


 


 


 It will then be necessary to carry out some short training. If the user is new to VR they should select ‘What to 
expect from Speech Recognition’ however, if the user has previous experience of using Dragon VR they can 
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 select ‘Radiology Reports’ instead. Users can also undertake additional Training via the Audio > Read text to 
improve my accuracy. 


 


 This will usually take around 15 - 20 mins, so although not recommended it is possible to skip this step and 
repeat the tutorial later. 
 


To Convert a Local User into a ‘Roaming’ User 


 
You can convert an existing Local User to a Roaming User with the Manage Users dialog box. 
 


 Make sure that the Roaming User feature is turned on. If a non-Roaming User is open, you must close it 
before you can open the Administrative Settings dialog box. (If necessary, click Close User on the 
‘NaturallySpeaking’ menu.)  


 


 Open the Manage User dialog box. (Click Manage Users on the ‘NaturallySpeaking’ menu.)  
 


 Use the list in the Location of user files box to select the location of the Local User you want to convert to 
a master roaming user.  


 


 Select the user you want to convert.  
 


 Click the Advanced button and then click ‘Save’ to Roaming. The program will save the user in the location 
specified as the Network directory in the Administrative Settings dialog box.  


 


 Repeat the process for any other Local Users you want to convert to master roaming users.  
 


To Copy ‘One or More’ Local Users into the Roaming Directory 


 
You can also copy one or more Local Users into the Roaming network directory, enabling you to convert a number 
of Local Users into roaming users within a single operation. 
 


 Double-click the My Computer icon and navigate to the location of the Local User files you want to convert to 
roaming users.  


 


 Select the files you want to copy, right click, and click Copy from the shortcut menu that appears.  
 


 Navigate to the roaming network directory, right click, and click Paste from the shortcut menu that appears.  
 


Please note: This is only usually possible if you have administrator level access on the workstation.
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 New - To Upgrade a Roaming Profile from a Previous Dragon Version – i.e. Dragon 11 


 
Roaming dragon voice profiles from previous versions of Dragon will need to be ‘upgraded’ to be used in Dragon 
12. 
 
In order to upgrade existing roaming dragon voice profiles you will first need to run the Acoustic Optimizer for all 
the existing profiles prior to the installation of Dragon 12.  
 
See the ‘Setting up and Running the Acoustic and Language Model Optimizer’ section of this document. 
 
If the Acoustic Optimizer is not run the following error message will be displayed when trying to upgrade:  
 
 
 
 
 
 
 
 
 
To upgrade the profiles: 
 


 Select the ‘Upgrade User Profiles’ from the Dragon tools menu and you will be presented with the following 
screen: 


 


 


 


 


 


 


 


 


 


 


 


 


 Click the [Browse to add a profile…] button and the browse for folder box will appear.  
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  Browse to the location of the roaming profiles. From here, you can select the entire directory or a single 
profile at a time: 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


Please note: Selecting the entire drive as shown above will select every profile. If you have a lot of profiles, please be aware it can take 
some time to perform the upgrade. All profiles must be closed (i.e. Not in use) at this time and the profile should have been already 
optimised by the Acoustic and Language Optimizer. 


 


 Before upgrading any user profiles, you will need to make sure the roaming option from the Dragon 
administrative settings is unchecked from the Dragon tools menu on the workstation where you are 
upgrading the user profiles. 


 
 
 
 
 
 
 
 
 


 If you do not uncheck the roaming profile option in the administrative setting, you will be presented with the 
following prompt and you will need to uncheck the roaming option before upgrading the profiles: 
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  Once you have selected your profiles, the next screen gives you a summary of your selections: 
 


 


 


 


 


 


 


 


 Click the [Next] button. You will need to select the location where to store the new upgraded profiles: 


 


 


 


 


 


 


 


 


 


 


 You can select the existing location of your current dragon voice profiles (the upgraded profile names will 
display v12 at the end of the profile name) or you can select another location. This is useful where disk space 
is limited at the original location. The profiles can be moved later if required. 


 


 Once you have selected the location to store the upgraded profiles click [Next]. The next screen shown below 
gives a summary of your selections: 
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  Once you are ready to perform the upgrade, click the [Begin upgrading] button. 
 


Please note: The average time to upgrade a profile depends on the size of the profile, but you should allow about ten minutes for each 
profile that needs to be converted. 


 


 When all profiles have been upgraded you should ensure that you re-check the roaming option in the 
administrative options if the option was previously ticked. 


 
 
 


 


 


 


 


 


Run Accuracy Tuning after Upgrading User Profiles 


To save time when it upgrades user profiles from earlier versions, Dragon initially processes only the most recent 
30 minutes of acoustic data. All corrections and new words trained in upgraded profiles are migrated. 


If you want Dragon to process all saved acoustic data from an upgraded profile, Nuance recommends that you run 
Accuracy Tuning after the upgrade to ensure that the maximum amount of data is migrated. 
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77..  AAccttiivvaattiinngg  CCRRIISS  aanndd  DDrraaggoonn  IInntteeggrraattiioonn  
 


ACTIVATING XR SETTINGS 


 
Please contact your system administrator to undertake the following tasks before using Voice Recognition. 
 
ROAMING PROFILES - Before you can start using Dragon Voice Recognition within CRIS you must have set up a 
Roaming User profile and completed the Dragon Voice Training.  


 
XR SETTINGS - The following XR Settings will also need to be activated at XRT (Terminal) level as this is the 
recommended level for VR. Unless otherwise advised - HSS do not recommend setting at XRS or XRTR level as 
only certain terminals are configured to use VR and any changes made to XR settings at Site or Trust level could 
adversely affect non VR users who have not disabled their VR profile. 
 


GENERAL XR SETTINGS 


 
 


 


 


 


 


VOICE.RecognitionInstalled = Yes 


This setting is designed to activate CRIS and Dragon integration and to enable the associated functionality and 


imbedded CRIS / Dragon commands.  
 


DRAGON XR SETTINGS 


 
The remaining settings should be set at XRS or XRTR level to enable these to be inherited by all subsequent 
Terminals. 
 


 
 
 
 
 
 
New – From CRIS 2.09.10s2 it is possible to configure the microphone reporting state: 
 
VOICE.DragonReportingStartState_AutoOFF = Sets the microphone recording state to ‘Saved’, ‘Off’, ‘On’, or 
‘Standby’ when reporting on a single event.  
VOICE.DragonReportingStartState_AutoON = Sets the microphone recording state to ‘Saved’, ‘Off’, ‘On’, or 
‘Standby’ when reporting using ‘Auto Select Next Exam’ via the ‘Report Info List’. 
 


***IMPORTANT PLEASE NOTE*** 
 
It is essential to set an appropriate default value via XRTR or XRS in order for Dragon to be correctly enabled upon logging into CRIS. This 
can then be configured per workstation based on Radiologist requirements. If the ‘Saved’ mic configuration setting is set the recording 
state will be the same as when the mic was last used. To avoid unintended transcription HSS do not recommend the ‘Saved’ configuration 
option. 
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 VOICE.DragonBarAtStartup = No. Setting this to No ensures that users cannot utilise the Dragon bar since its use 
will result in a reduction in the quality of integration, or in some cases disable the features altogether. This is due 
to the fact that Dragon will attempt to work independently and ignore commands sent by CRIS and leading to 
inconsistent results when reporting. 
 


VOICE.DragonCompatibilityModule = 0,0,0,0,0,0,0,1,1 (Dragon 11). It will be necessary for existing VR users to 
amend this setting as above (i.e. 7 x 0, 2 x 1) when implementing Dragon 12.  
 


Voice.DragonKillOnStartup = No (initially). This setting ensures that any Dragon processes are killed off before 
CRIS correctly launches Dragon. CRIS must be opened before Dragon to function as required. HSS recommend 
that this setting is set to ‘YES’ once all dragon voice profiles have been created, though this may not be required 
unless the Trust have an on-going issue with Users opening Dragon incorrectly ahead of CRIS. 
 


CONFIGURING SPEECHMIKE BUTTONS 


 
It is also possible to set the buttons on the SpeechMike to perform actions within CRIS.  
 
To do this you will need to create a format called ‘BUTTONS.DRAGON’ by clicking [New] via CRIS Setup Tables > 
System > FormatEditor and entering a New Format Name = BUTTONS.DRAGON and pasting the following text 
into the format editor as follows: 
 
PLAY=CRIS:playback 


RECORD=CRIS:record 


EOL=CRIS:focus 


INSERT=CRIS:startreport 


 
 
 
 
Having done this click [Save New Format] and proceed to configure the final Dragon XR Setting to enable this 
function. 
 
 
The following SpeechMike buttons can be configured: 
 
[PLAY], [RECORD], [REWIND], [FASTFOWARD], [EOL], [INSERT] with any of the following actions:  
 


CRIS:focus Returns the focus to the CRIS application. 


CRIS:playback Starts/stops audio playback. 


CRIS:record Starts and stops recording. 


CRIS:startreport Enters the examination title, starts the report text on the next line down. 
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 VOICE.DragonButtonConfig = DRAGON. Once the BUTTONS.DRAGON format has been created you should enable 


this for use via CRIS via the XR Setting. Having appropriately configured the necessary XR Settings, you should 


close and restart the CRIS system. 


 
 
 
 
 
 


LINKING CRIS AND DRAGON VOICE PROFILES 
 


Once VR is enabled the following message will appear upon logging to CRIS.  


 


 
 


 


 


 
Clicking [Yes] will display the following ‘Open User Profile’ screen and you should highlight the correct profile via 


the and click [OPEN] 


 


 


 


 


 


 


 


 


 


 


 


 
 


***IMPORTANT PLEASE NOTE*** 
 
To ensure CRIS and Dragon integration works correctly you should not load the Dragon Software independently. Consequently once all 
Dragon configuration and setup is complete you should close Dragon completely before launching the CRIS System. The CRIS application will 
launch Dragon Software automatically, to ensure that CRIS is able to fully control Dragon functionality and facilitate full integration. You 
should be aware that this does mean the Dragon Bar will not, and should not be displayed. However all required Dragon Tools are still 
accessible by right-clicking the Dragon Bar Icon in the Windows System Tray.  
 
 
 
 
 
 


 
Failure to allow the CRIS System to launch Dragon will result in a reduction in the quality of integration, or in some cases disable the features 
altogether. This is due to the fact that Dragon will attempt to work independently, in effect ignoring commands sent by CRIS and leading to 
inconsistent results when reporting. 
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88..  CCrreeaattiinngg  UUsseerr  SSppeecciiffiicc  TTeexxtt  CCoommmmaannddss  
 
Dragon NaturallySpeaking software allows users to set up their own commands.  By setting up Text and Graphic 
commands a user can quickly and easily create standard reports.   
 
To create a new command you should go to the TOOLS menu and choose VR Command Browser which will 
launch the Dragon Command Browser. 


 


 
 
 
 
 
 
 


 
 
 
 
 
 
 
 
 
 
 
To add a new command go to the MyCommands menu and choose [New] to display the following information 
into the MyCommands Editor Dialogue box: 
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MyCommand Name This is the ‘Command’ you will say whilst reporting and you should therefore aim to 


use words which would not occur in everyday reporting.  


 


Description A description of the reporting template. 


 


Group Set as ‘User-Defined’.  


 


[Train]  Click the [Train] button to train the Command Name and follow the on screen 


instructions. This step is essential for Dragon to accurately recognise your commands. 


 


Availability This should be ‘Global’ to ensure it can be used in CRIS. 


 


Command Type Text and Graphics will allow you to enter a block of text for this command. 


 


Content Type the text you want this command to enter into CRIS. 


 
Once you have saved the new command it can be used immediately within the CRIS application. 
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99..  DDrraaggoonn  VVooccaabbuullaarryy  
 
If you have purchased Dragon NaturallySpeaking Medical you should ensure that you select and use the 
Radiology vocabulary for maximum productivity and recognition. 
 


EDITING DRAGON VOCABULARY USING THE VOCABULARY EDITOR 


 
The vocabulary editor can be used to add, edit and train individual words and phrases although this should 
typically be undertaken during the reporting process using ‘SPELL THAT’ and ‘CORRECT THAT’ functionality. If you 
do wish to access the Vocabulary Editor you will need to close CRIS and launch Dragon individually to make the 
require amendments to your vocabulary. 
 


TRAINING OR ADDING AN UNRECOGNISED / UNKNOWN WORD 


 
This is an example of how to ‘TRAIN’ OR ADD AN UNRECOGNISED / UNKNOWN WORD FUTURE USE. Training 
Dragon via CRIS is very accurate but does not take effect until the next time CRIS is accessed since the Dragon 
voice profile is only saved upon exiting the CRIS client. Consequently if you intend to use the same word or phrase 
more than once during the same reporting session it is advisable to use the Dragon Vocabulary Editor. 
 
1. Right click the Dragon Menu and select the VOCABULARY MENU followed by OPEN VOCABULARY EDITOR. 


 


 
 


2. TYPE THE UNRECOGNISED / UNKNOWN WORD INTO THE [WRITTEN FORM] FIELD – i.e. 
supercalafragalisticexpialadoshus or Savage-Mady in these examples. If the word is already in the dictionary it 
will appear in box below and you will simply need to CLICK [TRAIN] to continue 
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 3. Alternatively if the word is not in the dictionary already you should also TYPE A [SPOKEN FORM] AND CLICK 
[ADD] and acknowledge and additional messages (i.e. Guess Pronunciation). You should then CLICK [TRAIN] 
as normal. 
 
 
 
 
 
 


 
 
 
 
 
 
 


Please note: Any personalised Vocabulary can be identified by a RED + 


 
4. Finally CLICK [CLOSE] and right click the Dragon Menu choosing the PROFILE MENU followed by SAVE USER 


PROFILE. Adding or Training words via the Dragon Vocabulary editor enables them to be used immediately via 
the CRIS reporting module.  
 
 
 


 
 
 
 
 
 
 
 
 


CHANGING WORDS / CHARACTER PROPERTIES 


 


EXAMPLE 1: CHANGE THE PROPERTIES OF PARENTHESIS  


 
This example looks at changing the properties of ‘Parenthesis’ to change to the more typical term of BRACKETS.  


To make this modification: 


1. OPEN THE VOCABULARY EDITOR via VOCABULARY MENU which is accessed via the Right Click Dragon Menu. 


2. Type a left bracket ( into the written form box to locate the ( bracket in the dictionary. 
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3. USE [CTRL – CLICK] to highlight the LEFT AND OPEN PAREN, AND RIGHT AND OPEN PAREN and CLICK 
[DELETE]. 


4. TYPE A ( LEFT BRACKET INTO THE WRITTEN FORM BOX and enter ‘OPEN BRACKET’ INTO THE SPOKEN FORM. 


5. CLICK [ADD] and then CLICK [TRAIN] and to amend the term used by Dragon for future use. 


6. Repeat this process for CLOSE BRACKET. Explain the user can do this for LEFT and RIGHT BRACKET in future if 
required. 


Please note: Any personalised Vocabulary can be identified by a RED + 


 


 
 


EXAMPLE 2: CHANGING WORD PROPERTIES TO USE AN ALTERNATIVE WRITTEN FORM 


 
This example looks at modifying the properties of the word ‘to’ to control how it appears when used between 
numbers – i.e. as the word ‘to’, or as a - dash 


 


1. OPEN THE VOCABULARY EDITOR via VOCABULARY MENU which is accessed via the Right Click Dragon Menu. 


2. Type ‘the’ into the ‘Written form’ box and select [Properties] 
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3. Tick ‘Use alternate written form 1’ and amend accordingly depending on your preference: 


    Alternative using ‘to’                  Alternative using ‘ – ‘ 


 


 
 


 


 


 


 


 


 


 


 


 


 


 
4. Ensure that ‘Only use alternate written form 1’ is ticked and select ‘between numbers’ before clicking [OK]. 


5. HSS would recommend that you also click [Train] to update your Dragon voice profile before saving the 
changes to your profile. 
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 ADDING THE RADIOLOGY VOCABULARY TO A PROFILE 


 
If the Radiology Vocabulary has not already been chosen, it can be added to the user profile. 
 
1. To do this select ‘Manage Vocabularies’ from the File Menu by right-clicking the Dragon Bar Icon in the 


Windows System Tray.   


 
 


2. When the Manage Vocabularies Dialogue box is displayed click [New] and type Radiology as the ‘Vocabulary 
name’ and select Base Radiology – Large as the ‘Based on’ Vocabulary. Click [OK] to save this new 
vocabulary. 


 
  
3. Having clicked [OK] the ‘Vocabulary Optimizer’ will appear. You do not need to undertake this step and should 


click [Cancel]. 
 


REMOVING VOCABULARIES FROM A USER PROFILE 


 
You may also want to remove the existing vocabulary once you have proven that the Radiology specific dictionary 
works, as it is not recommended to have more than two vocabularies per profile.   
 
You can remove vocabularies by selecting the Vocabulary you wish to delete and clicking [Delete]. 
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 IMPORTING A USER SPECIFIC VOCABULARY INTO DRAGON 


 
In the previous section you created a text document that is now ready to be imported into Dragon 
NaturallySpeaking as a user specific dictionary. 
 
1. Open Dragon and choose the ‘Tools’ menu - select ‘Accuracy Center’.   
 
Please note: You must have a User ‘Open’ to be able to select ‘Accuracy Center’.  You can ‘Open’ a user from the ‘NaturallySpeaking’ menu.  
The user that is currently open will inherit the new dictionary when you import the text. 


 
2. Click ‘Add words from your documents to the vocabulary’, a Add Words from Documents Dialogue box will be 


presented to you, click [Next] as follows: 
 


 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


3. The ‘Add Words from Documents’ dialogue box will remain on screen, choose [Add Document], Browse to 
and select the CRIS_initialsofDr_dictionary.txt file you saved previously then click [Next]. 
 


 
 
 
 
 
 
 
 
 
 
 
 







 


© Healthcare Software Solutions 2016  All Rights Reserved Commercial In Confidence 
Effective Date – ESM 30/03/2016   
HSS Doc ref:  CRIS_CRIB_VR_276_Voice_Recognition_12_v6.0.doc Page 47 of 61 


 


 


 4. Dragon will then carry out an analysis of the file (click [Next]) and will then display a dialogue box (as below) 
to enable you to decide if you would like to uncheck any words which are not frequently used. In this way you 
can choose to omit certain words in order to ensure that your own personal vocabulary is as up-to-date and 
context specific as possible. 


 


 
 
5. When you have selected the words you want to include in your dictionary click [Next] and continue to click 


[Next] on all subsequent screens until the process is completed.  
 
Please note: You will be given the option to ‘train’ Dragon on the words you are adding; you can do this during this process or you can 
choose to train at a later date if necessary.  You should be advised that this process can take some time – in some cases up to 15 minutes 
and HSS therefore recommend that you undertake this process at a suitable time when the workstation is not in constant use. 
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1100..  BBeesstt  PPrraaccttiiccee,,  CCoorrrreeccttiioonn  aanndd  TTrroouubblleesshhoooottiinngg    
 


 INPUT & DICTATION SOURCE 


 
It is possible to dictate using a PC Headset (supplied with Dragon License) or a Philips SpeechMike (not supplied 
with Dragon License. 
 
It is very important to choose the correct Dictation source via in the Dictation Source drop-down box when 
creating a new user. 
 
If the PC Headset has a USB connection, or you are using a USB microphone such as the Philips’ SpeechMike the 
dictation source should be set to USB Microphone. 
 
If the PC Headset does not have a USB connector it should be plugged into the standard Microphone and Headset 
ports on the workstation /terminal and the dictation source should be set to “Microphone Plugged into Mic 
Jack”. 
 


 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Please note: The ‘Radiology Vocabulary is only available when using Dragon NaturallySpeaking Medical. 


 


ADDING / CHANGING DICTATION SOURCE 


 
Should you wish to add an alternative Dictation Source, or in the event that you have selected the wrong 
Dictation Source, and would like to change to a different type of Microphone you can add / change the dictation 
source for a user.  
 
1. To do this select ‘Open User’ from the File Menu by right-clicking the Dragon Bar Icon in the Windows System 


Tray.   
 
2. Highlight the relevant User and clicking on the [Source] button.  
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3. You should then click [New] and choose the new Dictation Source (either Line-In Jack or USB Microphone) and 
click [OK] 


 


 
 


 
 
 
 
 
 


4. This will create an Additional Dragon User with the correct or alternative ‘Source’ and you may therefore wish 
to [Delete] the Original User with the original ‘Source’. Alternatively it is possible to have multiple Dictation 
Sources in the event that you use different Microphone in different locations (i.e. USB on one Workstation, 
and Mic In Jack on an alternative Workstation). 


 


CHECKING THE SOUND QUALITY OF YOUR DICTATION SOURCE 
 


If the source used for dictating into Dragon NaturallySpeaking is changed or if recognition seems to be impaired, 
then it is important to update the audio settings for your dictation source.   
 
1. To do this right click on the bottom right Dragon icon, then hover over ‘Audio’ and select ‘Check 


microphone…’ 
 


 
 


2. This will invoke the Audio Setting Wizard where you should undertake all 3 steps to confirm / configure the 
sound quality of your dictation. Firstly, make sure the correct device is selected then precede though the 
steps. 
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 NON DRAGON USERS IN CRIS 


 
Any CRIS user(s) working on a VR enabled Reporting Workstation, who do not wish to use Voice Recognition, or 
have not yet been trained to use Voice Recognition should click ‘No’ when prompted to select a profile when the 
user logs into CRIS for the first time on a VR enabled workstation. (Shown below) 
 
 
 
 


 


 


If at a later date the CRIS User wishes to begin using Voice Recognition, it is simply a case of removing the 
‘DragonUser=DRAGONDISABLED’ line from their STAFF > User Preferences to enable them to select their correct 
Dragon voice profile the next time they login to the system. Full instructions on ‘Changing a CRIS User’s Linked 
Dragon voice profile’ is highlighted below. 


 


SHARING VR COMMANDS (IMPORTING / EXPORTING USER COMMANDS) 
 


Dragon provides VR users with the ability to share commands either by importing, or exporting the files into 
specific user profiles, or by using the Data Distribution Tool in order to add and remove commands for all users.  
 


EXPORTING SPECIFIC USERS COMMANDS 


 
To EXPORT COMMANDS you should load the relevant user profile, and then open the command browser via 
Dragon > Tools > Command Browser 
 


 


 


 


 


 


 


 


You should highlight the ‘User Defined’ folder which is where users specific commands are stored, and select any 
commands that you want to export via the right hand ‘My Command’ pane. Once selected choose 'Export' via the 
left hand ‘Task Pane’.  


Please note: You can select multiple commands using [Ctrl + Left Mouse Click] 


When you click export you will be asked to choose a destination to save the exported commands before saving. 
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 IMPORTING SPECIFIC USERS COMMANDS 


 
This file can then be imported into a specific user profiles by loading the relevant user profile within Dragon, 
opening the command browser and selecting 'import'. You should then choose the relevant file containing the 
exported commands and once the commands have been successfully imported you will see the following 
message. 


 


 


  
 


DRAGON DATA DISTRIBUTION TOOL - IMPORTING COMMANDS TO ALL USERS 


 


You will need to begin by exporting the commands as per the ‘Exporting Specific User Commands’ instructions. 
You can then use the Data Distribution Tool located via Start > Dragon Medical 12 > Dragon Medical Tools > Data 
Distribution Tool. Select the 'Add or Remove shared commands' option and click [Next] before choosing the 
appropriate language. On the following screen click [Import] and choose the exported commands file previously 
created which will list the commands in the top section of this screen. 
 


 


 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Having done this click [Next], this will then begin importing the commands. If roaming is enabled and is mapped 
on workstation the commands will be imported to all users on the roaming share. If roaming is not enabled then 
the commands will be passed to all users who are set up on the individual terminal. 
 
Please note: Commands can be removed from all users using the 'existing shared commands section' and selecting remove.  
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Please note: The ‘Data Distribution Location’ should be set as a location to which all Dragon users have access to allow each user to import 
the available commands. A folder should be created at the location named ‘SharedCommands’, commands placed in the folder are 
available to all users. Commands will need to be trained by each Dragon user. 


 


CORRECTING DRAGON VOICE PROFILES 


 


Identifying which profile the user is linked to… 
 


When the user is logged into CRIS place the mouse cursor over the microphone icon to display which Dragon 
profile is currently loaded. 
 


 
 
 


Changing a CRIS User’s Linked Dragon Voice Profile 
 


In the event that a user wishes to change the Dragon voice profile that is linked to their CRIS User Account either 
due to a change in profile or due to error, the RIS System Manager should undertake the following course of 
action: 
  
1. Open the CRIS Staff Table and highlight the User Account you wish to amend: 
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2. Click the Preferences Tab for the selected user 


3. Locate the DragonUser setting  


4. Delete this setting by Right clicking and selecting [Remove] before clicking [SAVE].  


5. Close CRIS and Restart the application 


6. When the user logs back in to CRIS again they will be prompted to select a Dragon voice profile to link to 
their CRIS User account. 


 


Please note: You should not remove the value from the preference, the ‘DragonUser’ preference should be deleted in order for this to be 
reset. 


 


Disabling Windows Ctfmon.Exe 


 


The Nuance support and knowledge base highlights known issues where the Windows XP CTFMON.exe processes 
can interfere with Dragon often resulting in system lock up’s, freezes or problems regarding Dragon ‘Select and 
Say’ features. It is therefore recommended that this process is disabled in the event of any similar problems, since 
the CTFMON.exe is not required. 


Instructions on how to undertake this are available via the Nuance Support Knowledge base, and can be accessed 
directly via http://nuance.custhelp.com/app/answers/detail/a_id/2497. 


Anti-Virus Software 


 
When launching or using Dragon NaturallySpeaking, it is possible that third party Anti-Virus software may 
interfere with Dragon. These interferences may include dictation being blocked, or the Anti-Virus software may 
show an alert that the "natspeak.exe" process is possible malware.  
 


Cause: Dragon NaturallySpeaking connects to applications for tracking windows, text fields and dialog boxes. This 
connection may be improperly detected as an intrusion by the Anti-Virus software.  
 


Solution: To ensure that the Anti-Virus software does not interfere with Dragon NaturallySpeaking, add the 
Dragon installation directory to the Anti-Virus program's exception list.  
 


Please note: The steps for adding an exception will vary with different Anti-Virus software. Please consult the Anti-Virus program's Help File 
for the exact steps on adding an exception.  


 


The following Dragon NaturallySpeaking directories should be added as exceptions:  
 


Windows XP… 
All Files/Folders in C:\Program Files\Nuance  
All Files/Folder in C:\Documents and Settings\All Users\Application Data\Nuance  
All Files/Folders in C:\Documents and Settings\ [windows login account]\Application Data\Nuance  
 Windows Vista / 7… 
All Files/Folders in C:\Program Files\Nuance  
All Files/Folders in C:\ProgramData\Nuance 
All Files/Folders in C:\Users\Dragon\AppData\Roaming\Nuance\ 
The local cache location (if configured for a custom value and different from the above defaults). 


 
Please note: If the Anti-Virus program asks whether to include all sub-folders and files to the exception list, select Yes. 


 



http://nuance.custhelp.com/app/answers/detail/a_id/2497
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1111..  EEsssseennttiiaall  HHoouusseekkeeeeppiinngg  
 


What is the Acoustic and Language Model Optimizer? 


 
As you make and train corrections, train new words, use commands, and perform additional training, Dragon 
stores the acoustic and language data in an archive and uses it to enhance recognition accuracy and ‘learn’ any 
changes you have made.  
 
The Acoustic and Language Model Optimizer updates your User Profile with accumulated acoustic data from your 
corrections and any additional training you have performed as well as to add commonly used word sequences to 
the Language Model. Running the Acoustic and Language Model Optimization increases your overall accuracy. 


 
The Language Model contains statistical information that predicts which words are most likely to occur in the 
context of your speech. Language Model Optimization uses text extracted from your User Profile's .DRA files to 
add commonly used word sequences to the Language Model. 
 
HSS strongly recommend that the Acoustic and Language Model Optimizer is scheduled to run weekly in order to 
ensure that users always have access to the most up-to-date and streamlined profiles. Failure to run the Acoustic 
and Language Model Optimizer will result in a degeneration of recognition, and the appearance that Dragon is not 
learning in spite of any training undertaken by the user. 
 
Please note: Dragon will only collect this data if the correct configuration settings have been selected as detailed in the above document. 
The windows scheduler is required to run the Acoustic and Language Model Optimizer 


 


Setting up and Running the Acoustic and Language Model Optimizer 


 
HSS also suggest that the Acoustic and Language Model Optimizer is run from server where the profiles are stored 
as this is the most time efficient in terms as it negates network speed issues, any loss of access to profiles and 
should also be subject to the standard system backup. Dragon will need to be installed on the Roaming profiles 
server sing Remote Desktop Protocol (RDP) and can then be scheduled to run from there as per the following 
instructions.  
 
Please note: The roaming option (via Dragon administrative Settings) will need to be disabled on the server/workstation you are running 
the acoustic Optimizer. 


 
The system administrators’ computer can also be used to run the Acoustic Optimizer, but it will take longer if not 
the same location as the profiles and will need Dragon installed and access to the roaming location.  
 
The Acoustic and Language Model Optimizer is found via Start > All Programs > Dragon 12 > Dragon Medical 
Tools> Acoustic and Language Model Optimizer Scheduler. Once the ‘Acoustic and Language Model Optimizer’ 
has loaded you will need to set the Roaming directory. To do this click [File] then [Set User Directory] and then 
browse to the below location. 
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 Once this location is set, you should see the users’ profiles populate the left side pane as per the below 
screenshot. 


Please note: This may take some time depending on the amount of profiles you have stored on the roaming location. 


 


Next, you will need to schedule a task to optimize a user profile. To do this click the far left icon which is 
highlighted below or choose File > [New Task]. You will then be prompted to enter your windows password. 


 


The next screen is where you select the profile(s) you would like to optimize and when you would like this to 
occur. 
 


Please note: You will need to ensure that the user’s profile is not in use when you intend to run the optimizer. We advise the Acoustic and 
Language Model Optimizer is set to run out of hours to avoid this issue. 


 


RUNNING AN INITIAL TEST 


 
HSS would recommend that you begin by setting up an initial test for one user to confirm that the process 
completes as expected, and test the speed of connection if not installed on the Roaming server. 
 
Select a User Name from the drop down list of users, and ensure that the top two boxes (‘Perform Acoustic 
Optimization’ and ‘Perform Language Model Optimization’) are ticked so that the acoustic and language models 
are both optimised. 
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Having done this select the ‘One Time Only’ and ensure that the Start Date is today and Start Time is 2-3 mins 
from the current time and click [OK] to schedule the task. 
 


CONFIGURING THE ACOUSTIC AND LANGUAGE MODEL OPTIMISER FOR ALL USER PROFILES 


 
Having tested the Acoustic and Language Model Optimizer on one user, you can now extend this to cover all ser 
profiles. You should again ensure that the top two boxes (‘Perform Acoustic Optimization’ and ‘Perform Language 
Model Optimization’) are ticked so that the acoustic and language models are both optimised.  
 
Then select the users you would like to run using the [Multiple Users] function button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Add all relevant Users individually using [Add >] or [Add All >>] and click [OK] to exit this screen. 
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Once the above has been set, click [Apply] then [Ok]. This will then send you to the main screen shown below. 
 


  
 


You should now be able to see the scheduled task in the right side panel. When you have scheduled the tasks 
close the scheduler and the Acoustic and Language Model Optimizer will start to run when the time reaches the 
one specified within the ‘Next Run Time’ column.  
 
Once this has completed the ‘Last Run Time’ and ‘Last Result’ columns will be populated. The Acoustic and 
Language Model Optimizer can take time to complete, and does vary depending on the amount of data to 
process. However the more frequency the process is run the more efficient the process will be. 
 
Please note: Sometimes it may be necessary to refresh the window yourself by clicking on the yellow sun icon to display the result.  


 


The results the Acoustic and Language Model Optimizer can display are shown below with an explanation on each 
term: 
 


Last Result Explanation 


Success The Acoustic and Language Model Optimizer has run successfully 
for the user. 


No New Data There is not enough or no new data for the Acoustic and Language 
Model Optimizer to optimize. 


Failed The Acoustic and Language Model Optimizer has not completed. 
The error should then be visible within the Dragon.log 


 
Please note: The ‘no new data’ result could be caused by a configuration issue, as incorrect setup can stop the required files from being 
saved. Please refer to Configuring Roaming Profiles in Dragon NaturallySpeaking to check roaming settings. 
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 Optimizer Questions 


 


I’m unable to schedule any task and keep encountering an error? 


We have found that if there is a corrupt profile present on your network share then the Acoustic and Language 
Model Optimizer will prevent you scheduling a task for any user. We now have a small program which can be run 
to check for corrupt profiles. 


 


How often should the Optimizer be run on each profile? 


We recommend you run the Optimizer out of hours on a weekly basis. The more regularly you run the Optimizer 
more efficiently it will run. It has been established that monthly scheduling is not sufficient as the user profiles 
grow and degenerate over this period and the longer the gap the longer the Optimizer takes to run. 


 


1122..  FFrreeqquueennttllyy  AAsskkeedd  QQuueessttiioonn  
 


Q. How many workstations can I log into using CRIS and Dragon VR? 


 
A. You can only be logged into one workstation at any one time when using Dragon roaming profiles. 
 


Q. What should I do if the Dragon voice profile does not load when logged into CRIS? 


 
A. Refer to section Changing a CRIS User’s Linked Dragon voice profile. 
 


Q. How do VR Profiles become corrupted? 


 
A. Dragon profiles can become corrupted in a number of ways which are predominantly attributable to network 
failures or user error as follows: 
 


 The disk where the profiles are stored becomes full which will corrupt all profiles. 


 


 The profile did not save fully to the roaming profile folder – i.e. Due to network pauses or most commonly 


users turning off the PC without closing applications safely. 


 


 The same user logged into more than one terminal, as Dragon voice profiles cannot be loaded in more than 


one location. 


 


 Using someone else’s windows network login as it can’t sync with your own profile. 


 
If you experience corrupted profiles corruptions you should contact the HSS Helpdesk for guidance on restoring 
profiles, which may involve providing the Dragon.log which is located in 
C:\Users\UserName\AppData\Roaming\Nuance\NaturallySpeaking11. 
 


Q. Why can’t I access the Command Browser from the Dragon right-click menu? 


 
A. The Command Browser can now be found within CRIS under the Tools option. Refer to section 8 - Creating 
User Specific Text Commands. 
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 Q. Why does it sometimes appear that Dragon does not learn my new words and phrases correctly? 


 
A. There are two potential reasons for this as follows: 
 


 Training Dragon via CRIS is very accurate but does not take effect until the next time CRIS is accessed 
since the Dragon voice profile is only saved upon exiting the CRIS client. Consequently if you intend to use 
the same word or phrase more than once during the same reporting session it is advisable to use the 
Dragon Vocabulary Editor. Refer to ‘Editing Dragon Vocabulary using the Vocabulary Editor’. 
 


 The acoustic and language model Optimizer needs to be routinely undertaken to optimise the user’s 
vocabulary files. Refer to ‘What is the Acoustic and Language Model Optimizer?’ 


 


Q. What if the microphone volume is too low while reporting? 


 
A. This often occurs when the Workstation is used for both digital dictation and voice recognition. The 
microphone will need to be re-calibrated. This can be accessed from the right-click Dragon Menu via Audio and 
the ‘Check Microphone’. Refer to ‘Checking the Sound Quality of your Dictation Source’. 
 


Q. Why does Dragon keep prompting me to check the Mic, once it has already been configured on the 


workstation? 


 


The first time a Roaming User logs on to a workstation Dragon will ask to configure the Mic settings. If you 
continue to be prompted to check the Mic on subsequent session using the same workstation, Dragon does not 
have the correct permissions to the local roaming folder and the changes are not being saved, which means 
customs commands will not be saved either.  
 
The most likely scenario is they do not have inherited modify permission’s to the local roaming folder so the 
microphone training is not being saved and for custom commands, Dragon cannot write to the mycmds.dat file 
where all the commands are kept.  The folder could have modify permissions but if not set to inheritance all child 
folders and files (i.e. mycmds.dat) will only be read and execute – Refer to ‘Configuring Roaming Profiles in 
Dragon NaturallySpeaking’. 
 
Please note: This will occur if the SpeechMike is routinely unplugged and reinserted into different USB ports on the machine (i.e. A Laptop) 
as Dragon will validate the windows plug and play device on each occasion. 


 


Why do some profiles corrupt when using Dragon roaming profiles across multiple sites? 


 


If you are experiencing roaming profile corruption for users who are reporting across multiple sites (and the 
profile share is in a single location) you can tick the ‘Access network at user profile open/close only’ via the 
Dragon ‘Administrative Settings’ roaming tab. When this option is ticked Dragon will only connect and 
synchronise data only when it opens and closes, rather than synchronising regularly. If you are still experiencing 
profile corruptions after making this change. Please notify the HSS helpdesk for support. 
 


Q. Why do some radiology reports appear abridged when viewed in PACS / PACS / OCS? 


 


HSS recommend that Clinical Reports should only include ASCII character sets and should not include any non–
printable control characters outside of the standard A-Z, a-z, 0-9. Additionally, when dictating clinical reports 
please do not make use of either ~ Tilde or | Pipe/Vertical Bar symbols as these characters are used as Field 
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 delimiters in HL7 interfaces. Field delimiters separate data fields – i.e. When PACS/PAS/OCS interfaces receive 
messages from CRIS they use HL7 Field delimiters to parse data into the correct fields 
 
HSS has also established that the ‘–’ (extended dash) symbol is treated as an illegal character via HL7 interfaces 
(as it is classed as a Unicode Carriage Return) and this results any text after this character being rejected by the 
interface – (i.e. partial or abridged reports). 
 
You should therefore ensure that dash, N Dash and M dash are deleted from the User Vocabulary. It is then 
possible to [Add] ‘-’ dash back into the vocabulary and [Train] if required or simply make use of the hyphen 
instead. 
 
 
 
 
 
 
 
 
 
 


 
 
 
 
 
 
 


Q. Why don’t my ‘VR Command Browser’ report templates work when looking at images in PACS? 


 


In order to use templates which have been created in the ‘VR Command Browser’ the focus must be within the 
‘Report Editor’ within the CRIS application. It is common for the application focus to be moved to PACS when 
images are viewed/manipulated, the focus needs to be returned to CRIS in order to use the template. 
 
The focus can be returned to the CRIS application using the mouse to click back into the CRIS Report Editor or a 
button on the SpeechMike can be configured to return the focus to the CRIS application, see the section on 
SpeechMike buttons configuration within this document. 
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Export and import Commands in Dragon. 
 


At some point you might wish to export one or more commands from Dragon Naturally Speaking 
for use for other users to use. This document explains how to export and import Dragon 


commands. 


 


To export a command using dragon. 


 Open dragon on a workstation  and open the user’s profile you wish to export the command 
in the open user profile box. Then click the dragon tools option and select command browser.  


 
 
 
 
 
 
 
 
 
 


 


Once the command browser box is open, select the command you wish to export, then click 
MyCommands and select export. 


Note: custom commands are in the User-defined folder unless specified. 


 


 


Next the exports commands box will open. Select the location you with to save the command to. 
(For example the desktop). Give the command a name. (The default save as type should be *.dat) 


then click save. 


“See Screenshot below” 


 







 
 
 
 


 
 


To Export a command while logged into Cris the procedure is the same except you can select the 
command browser directly from Cris.  


Note: only the commands for the current logged in user will show.  


So, it’s easier to open Dragon on its own then you can select any user profile you need to export 
the required command. 


 


 


 


 


 


 


 


 


 







 
 


To Import commands into Dragon 


To import a command or all your commands into Dragon the procedure is the same except you 
select the import option and browse to the command file (Mycmds.dat) that you wish to import 


and click open.  


 


The following box will appear, as shown in the screenshot below. 
 


 By default, all commands are selected, you can import them all or select just those ones you wish to 
import by selecting “Uncheck All” and then checking only the commands you wish to import. Click the 
Import button and your commands will be imported into your profile and will now show in the command 
browser.  
 
Note: The other folders are the default commands that come with dragon. 
 


 
 


 
Note: The location of the command file will be for example (for a mapped drive V:\dragon\my profile 
folder\current\MyCmds.dat) This will be the location where the profiles are stored on the network share to 
make sure get are importing the most up to date version of the file. 
 
 
 







 
 


Export saved words and phrases to any version of dragon. 
 


If you wish to move or add you’re saved words and phrases to a new dragon profile, you can do this using 
the using the export custom words and phrase list from the vocabulary option on dragon. (See Screenshot) 
 
Note: To see a list of all your custom words in your vocabulary. Open the vocabulary editor from the 
vocabulary option.  In the vocabulary editor, select the Display option at the bottom and select custom 
words. 
 


 
 


Select export custom word and phrase list 
 


 
 


Give the file a name such as words_and_phrases_export and click save. This saves all you custom words 
and phrases that you have added to your dragon profile. 
 
Please Note: the dragon vocabulary is a base vocabulary that contains a standard dictionary for the field 
you have selected such as (Radiology) this dictionary is added when a new profile is created. The custom 
words and phrases are new words and phrase that have been added after the profile was created. 
 
 


 


 







 
 


Select a location where you wish to save the file, such as the windows desktop. 
 


 
 


Importing saved words and phrases to any dragon profile. 
 


To import saved words and phrases to a dragon profile, click the import custom words and phrase list from 
the vocabulary option on dragon. (See Screenshot) 
 
 


 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 







 
 


You will see the following wizard appear. 
 


 
 


 
Check the (Preview the list of unknown words) and then click the next button and then add the exported 
words and phrase file from your saved location and then click next. 
 


 
 


Dragon will analyse the file and show any words and phrases that are not currently in your vocabulary. You 
can select all or any amount of words. You can even edit them in this section if required. 
 







 


 
 
Click next and “select the words and phrases you wish to add and click next then finished and they will be 
added to your vocabulary. 
 
Next you will see a notification saying the changes will not be copied to the network profile until the profile 
is saved. 
 
 


 
 


To save the profile, go to the profile option and click “save user profile”. 
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